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1 Johdanto 
 

Opinnäytetyöni tavoitteena on antaa lukijalle kattava kuvaus siitä, 
miten katalogin suunnittelu ja tuottaminen etenee teoriassa ja käy-
tännössä. Esittelen asiat siinä järjestyksessä, kuin tuotekuvaston, eli 
katalogin teko eteni omalla kohdallani tehdessäni Hoo-Hoo Oy:n ka-
talogia. Opinnäytetyön tehtävänä on toimia tukena ja ohjeena henki-
löille, joilla on aikomuksena aloittaa katalogin tekeminen. Työssä on 
tarkoitus löytää ne keskeiset ongelmakohdat, joita katalogin tekemi-
sessä tulee eteen. 
 
Opinnäytetyön aiheen sain ollessani harjoittelussa Hoo-Hoo Oy:ssä. 
Hoo-Hoo Oy on Lempääläinen pienyritys, joka tarjoaa asiakkailleen 
mainoskalentereita sekä liikelahjoja. Harjoitteluuni kuului katalogin 
suunnittelu ja tuottaminen yritykselle sekä WWW-sivujen päivitys. 
Yrityksellä ei ole ennen ollut katalogia. Tämän vuoksi opinnäyte-
työni antaa myös hyvän pohjan uuden katalogin suunnitteluun, sillä 
näin on olemassa jo jokin toimintasuunnitelma, minkä mukaan ede-
tä. 
 

 Kirjallisuus 
 

Kirjallisuutena olen käyttänyt kirjoja, jotka käsittelevät painoalaa 
yleisesti ja kirjaa, joka kertoo digitaalisesta painamisesta. Kuvankä-
sittely-osion kirjoittamista varten olen tutustunut valokuvaamista, 
Photoshopin käyttöä ja kuvankäsittelyä käsittelevään kirjallisuuteen. 
Esimerkiksi Pertti Koskisen kirja on perusteellinen teos painoalasta, 
kun taas Lehtosen, Mattilan, Veilon ja Ranisen kirja keskittyy digi-
taaliseen painamiseen. Vaikka Koskisen kirja on vuodelta 2001, eikä 
näin ollen tarjoa aivan uusinta tietoa, uskon että sen antamat tiedot 
ovat kuitenkin luotettavia sillä kirjoittaja on kirjapainoalan asiantun-
tija. 
 
Pasi Kainulainen on multimedian ammattilainen ja tietotekniikan 
kouluttaja. Kirja kertoo perustavasti kaiken Photoshop-ohjelmasta ja 
kuvien käsittelyyn liittyvistä asioista. Kirja on ajan tasalla, sillä se 
on julkaistu vuonna 2006. 
 
Digitaalinen painoviestintä -kirjan kirjoittajista Mattila on laatinut 
opetussuunnitelmaa painoviestintäalalle ja Raninen on ollut mukana 
oppimateriaalituotannossa. Digitaalinen painoviestintä antaa tietoa, 
miten digitaalinen painaminen tukee osaltaan perinteistä painamista. 
 
Keräsen, Lambergin ja Penttisen teos on tarkoitettu peruskirjaksi di-
gitaalisen median opiskeluun. Se antaa hyvät perustiedot aiheesta ja 
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toimii hyvänä johdatuksena aiheeseen - tosin melko pelkistetysti. 
Kirjoittajat työskentelevät digitaalisen median eri osa-alueilla ja ovat 
julkaisseet oppaita. Kirja on julkaistu vuonna 2005, joten se antaa 
ajan tasalla olevaa tietoa. 
 
Martin Evening on digitaalisen kuvankäsittelyn konsultti ja valoku-
vaaja. Hänen teoksensa vuodelta 2005 on ajan tasalle saatettu versio 
aiemmasta teoksesta. Kirja on tarkoitettu harrastajille ja ammattilai-
sille. Se antaa monipuolista ja syvällistä tietoa valokuvaukseen liit-
tyvistä asioista. 
 
Milla Toro on graafisen suunnittelun ja painotöiden tekemisen am-
mattilainen. Vuonna 1999 julkaistu kirja kertoo monipuolisesti pai-
notöiden tekemisestä, mutta on jossain kohdin ehkä hieman pinta-
puolista. 
 
Pertti Lukkarilan InDesign julkaisijan työvälineenä -kirjaa käytin 
apunani värinhallinasta kertoessani. Kirja antaa monipuolisen kuva-
uksen värienhallinnasta, vaikka on vuodelta 2000. 
 
Olen käyttänyt opinnäytetyössäni lähteenä myös muutamia Internet       
-sivuja. Internet-sivuja en ole kuitenkaan hirveästi hyödyntänyt nii-
den epäluotettavuuden vuoksi. Hintikan Heli, joka on kirjoittanut vä-
rinhallintatietopaketin, vastaa Oululaisen yrityksen, Pixhelin toimin-
nasta. Hän on ammatiltaan valokuvaaja. Lähteenä olen käyttänyt sel-
laisia tietoja tietopaketista, jotka ovat esiintyneet muissakin kirjois-
sa, ja jotka ovat selitetty Hintikan tietopaketissa kansantajuisemmin. 
Opetushallituksen sivuilta käytin kuvaa väriympyrästä. 

 

 Hoo-Hoo Oy 
 

Hoo-Hoo Oy on vuonna 1989 Lempäälään perustettu perheyritys, 
jonka toimialana on liike- ja mainoslahjojen maahantuonti ja tukku- 
ja vähittäismyynti sekä silkkipainotoiminta. Hoo-Hoo Oy:n päätuot-
teena ovat Ajaston seinäkalenterit. Yrityksen tuotevalikoimaan kuu-
luvat mainoskalentereiden lisäksi erilaiset liikelahjat. 
 
Hoo-Hoo Oy:n asiakaskunta koostuu jälleenmyyjistä sekä muun 
muassa yksityisistä yrityksistä, julkisista sektoreista sekä yhdistyk-
sistä ja organisaatioista ympäri Suomea. Hoo-Hoo Oy:n asiakaskun-
ta on pitkään ollut vakituinen ja vakaa, koska yrityksen perustaja 
Hannu Hietala ehti olla alalla yli kolmekymmentä vuotta ja sinä ai-
kana syntyi pitkäaikaisia ja hyviä asiakassuhteita. 
 
Vuonna 2005 yritys siirtyi uuden sukupolven aikaan, kun Heidi Hie-
tala astui yrityksen johtoon. Yrityksen toimintatapa jatkuu entisel-
lään, mutta yrityksessä panostetaan tällä hetkellä enemmän markki-
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nointiin ja toiminta on aikaisempaa asiakaslähtöisempää. Hyvänä 
esimerkkinä yrityksen toiminnan uudistuksesta ovat yritykselle ava-
tut WWW-sivut sekä oma kuvasto. 
 
Hain harjoittelupaikkaa Hoo-Hoo Oy:stä keväällä 2006. Olin kuul-
lut, että yritys haluaisi toteuttaa oman tuotekatalogin. Sovimme pa-
laverissa tuotannon aikataulusta ja muista käytäntöön liittyvistä asi-
oista. Katalogin tuli olla valmis kesä-heinäkuun vaihteessa. 
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2 Painotuote 
 
Katalogin suunnittelussa täytyy ottaa huomioon useita eri asioita, 
kuten esimerkiksi painopaperin koko ja millä painomenetelmällä 
julkaisu painetaan. Lisäksi suunnittelussa täytyy pitää silmällä, mi-
ten eri sisältöelementit pystytään sommittelemaan sivulle siten, että 
tuloksena on mukavan näköinen sivu. 
 
Näyttölaitteissa ja painokoneissa on käytössä eri värijärjestelmät. 
Viimeistään ennen katalogin painoon lähettämistä julkaisu täytyy 
muuttaa värijärjestelmästä toiseen. 
 
 

2.1 Värijärjestelmät 
 

Ihmissilmä näkee sähkömagneettisen säteilyn spektristä vain osan. 
Tämän näkyvän valon aallonpituus on noin 400-700 nanometriä. 
Ihminen aistii nämä aallonpituudet väreinä. Auringon valossa on 
kaikkia näkyvän valon aallonpituuksia (Keränen, Lamberg, Pentti-
nen. 2005: 74). Värijärjestelmillä, joita kutsutaan myös värimalleik-
si, kuvataan ja luokitellaan värejä, joita ihminen näkee. 
 
 

2.1.1 Additiivinen värijärjestelmä 
 

Additiivinen, eli lisäävä värijärjestelmä perustuu valon päävärien 
yhdistelemiseen. RGB-värijärjestelmä on additiviinen värijärjestel-
mä. Valon päävärit ovat punainen, sininen ja vihreä (Kuvio 1). Yh-
distelemällä tietyssä suhteessa päävärejä saadaan muodostettua val-
koista valoa. Esimerkiksi näytön kuva vaalenee, kun valoa lisätään. 
Toisilla päävärien yhdistelmillä voidaan tuottaa välivärejä. (Keränen 
ym. 2005: 77, 78.) 
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Kuvio 1 Additiivinen värijärjestelmä 
 
Additiivista värijärjestelmää käytetään esimerkiksi tietokoneen näy-
töissä ja televisioissa. Näytöllä on tiheään punaisia, sinisiä ja vihreitä 
valopisteitä ja kuva muodostuu näiden pisteiden yhteisvaikutuksesta, 
kun värit projisoidaan näytölle. Kohdissa, joissa tarvitaan mustaa vä-
riä, ei ole näkyvää valoa. 
 
 

2.1.2 Subtraktiivinen värijärjestelmä 
 

Subtraktiivinen värijärjestelmä, toisin kuin additiivinen, perustuu vä-
rien vähenemiseen sitä mukaa kun mustetta lisätään (Kuvio 2). Siksi 
sitä kutsutaan myös vähentäväksi tai heijastavaksi värijärjestelmäksi. 
Siihen, minkä värisenä näemme kohteen, vaikuttaa kohteen pinta. 
Punainen kohde näyttää punaiselta, koska se heijastaa punaisen aal-
lonpituuden takaisin ja imee itseensä muut aallonpituudet. 
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Kuvio 2 Subtraktiivinen värijärjestelmä 
 
Subtraktiivista värijärjestelmää käytetään kirjapainoissa ja väritulos-
teissa, sillä siinä yhdistetään väriaineita, esimerkiksi painovärejä. 
Värien muodostamiseen käytetään kolmea värillistä mustetta syaa-
nia, magentaa ja keltaista. Kun näitä kolmea väriä painetaan päällek-
käin, saadaan muodostettua mustaa väriä. CMYK-järjestelmän ni-
mikirjaimet tarkoittavat siis syaania (C), magentaa (M), keltaista (Y) 
ja mustaa (K). Painovärien sekoituksena muodostettu musta ei kui-
tenkaan ole täysin mustaa, tämän vuoksi käytetään kolmen värin li-
sänä mustaa painoväriä. Tätä nelivärijärjestelmää kutsutaan CMYK 
-järjestelmäksi. Mustaa painoväriä käytetään CMYK-järjestelmässä 
tekstissä ja kuvan tummissa kohdissa. Yhdistelmällä syaania, ma-
gentaa ja keltaista värimustetta, saadaan muodostettua CMYK-väri-
järjestelmän värisävyt. (Pesonen & Tarvainen 2001: 57.) 
 
Alla olevasta kuviosta näkee, miten CMYK-värien värinmuodostus 
toimii (Kuvio 3). Värit painetaan toistensa päälle, jolloin syntyy ha-
luttu väri. Riippuen siitä, mitä väriä paperille painetaan, heijastuvat 
tietyt värin aallonpituudet takaisin ja vaikutelma väristä syntyy. Kir-
jaimet R, G ja B ovat lyhenteet punaisesta, vihreästä ja sinisestä. 
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Kuvio 3 CMYK-värien värinmuodostus (Kleper 2001: a) 

 

2.1.3 PMS-värijärjestelmä 
 

Kirjapainoissa käytössä oleva värijärjestelmä, joka on tunnetuin niin 
sanotuista spottivärijärjestelmistä. Lyhenne PMS tulee sanoista Pan-
tone Matching System. PMS-värijärjestelmässä haluttu väri valitaan 
PMS-värikartan mukaan ja käytettävät värit ovat valmiita sekoituk-
sia. PMS-värijärjestelmässä on käytössä 14 erilaista värisävyä ja näi-
tä sekoittamalla voidaan saada n. 1000 eri värisävyä (Koskinen 
2001: 90). Värikartoista selviää, millaiselta painettu väri näyttää 
päällystetyllä ja päällystämättömällä paperilla (Toro 1999: 95). 

 

2.1.4 Painotöiden värisyys 
 

Yksivärityössä käytetään vain yhtä PMS-värikartan painoväriä. 
Työn ei kuitenkaan tarvitse olla mustavalkoinen, vaan valittu väri 
voi olla mikä tahansa ja se voi sisältää värin eri sävyjä (Toro 1999: 
92). Yksivärisen työn painoalustaksi voidaan myös valita jokin väril-
linen paperi, jolloin työhön voidaan saada näin enemmän huomioar-
voa (Koskinen 2001: 94).  
 
Kaksivärityössä valitaan kaksi väriä, joilla työ painetaan (Toro 1999: 
92). Yleensä toinen väreistä on musta ja toista käytetään koristevä-
rinä otsikoissa ja kehyksissä (Koskinen 2001: 95). Kolmivärityössä 
työhön voidaan valita kolme eri väriä ja sitä kutsutaan triotone-pai-
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namiseksi. Työstä riippuen kolmivärityö voidaan painaa käyttäen 
CMYK-värejä (Koskinen 2001: 95). 
 
Nelivärityö tarkoittaa yleensä CMYK-väreillä painettua työtä. 
CMYK-värejä käytettäessä ei työstä tule yhtä kirkasta väreiltään 
kuin PMS-värejä käytettäessä, mutta se on hinnaltaan halvempaa 
tuottaa (Toro 1999: 92). Värivalokuvia käytettäessä työt tulee aina 
painaa käyttäen CMYK-värejä (Koskinen 2001: 96). 
 
Jos painotuotteeseen halutaan enemmän värejä ja värisävyjä, onnis-
tuu se HiFi Color -tekniikkaa käyttämällä (Kuvio 4). Käytettäviä 
HiFi Color -tekniikoita ovat CMYK+CMY, CMYK+RGB, HexaCh-
rome ja IndiChrome. Käytännössä jokaisessa tekniikassa CMYK-vä-
rien rinnalle on lisätty lisävärejä. CMYK+CMY -tekniikassa värit 
painetaan toistamiseen ilman mustaa väriä. CMYK+RGB käyttää li-
säväreinä punaista, vihreää ja sinistä. HexaChrome:ssa oranssiin ja 
vihreään lisäväriin on lisätty fluoresoivia partikkeleita, jolloin vä-
riavaruus kasvaa. IndiChrome-menetelmässä lisävärit ovat oranssi ja 
tumman violetti. (Koskinen 2001: 97.) 
 

 
 
Kuvio 4 Eri tekniikoiden ja ihmissilmän käsittämät värisävyt (Kos-
kinen 2001: 96) 
 
Värien käyttö painotuotteessa vaikuttaa aina jossain määrin paino-
työn hintaan. Koskisen (2001: 94) mukaan yksivärinen painatus on 
edullisin vaihtoehto, kun painosmäärä on alle 5 000 kpl. Väreillä to-
teutettu painotuote kuitenkin yleensä huomioidaan paremmin kuin 
mustavalkoinen vastaava. Tietysti mustavalkoinen tai harmaasävy-
kuva esimerkiksi mainoksissa oikein käytettynä voi olla värillistä 
versiota parempi vaihtoehto. Tuotekatalogissa värit ovat kuitenkin 
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tärkeässä asemassa, sillä katsoja näkee ensisilmäyksellä, miltä tuote 
näyttää oikeasti. Tätä informaatiota ei yksivärinen kuva pysty tar-
joamaan, vaikka tuotteen eri värit olisi luetteloitu kuvan vieressä. 
 
 

2.2 Paperi 
 

Paperin koko näyttelee suurta roolia tuotekuvaston suunnittelussa. 
Jos arkkikoko on liian pieni, kaikki kuvat, joita sivuille aiotaan lait-
taa, eivät välttämättä mahdu sinne. Toisaalta jos paperin koko on lii-
an suuri, kuvat asettuvat harvaan ja paperilla tulee olemaan liikaa 
tyhjää tilaa. Paperin koon valinta tulee varmastikin jossain vaiheessa 
katalogin tekoa ajankohtaiseksi. Yleensä painopaperiksi valitaan jo-
ku paperistandardin koko (Kuvio 5) (Koskinen 2001: 63). Katalogin 
ei kuitenkaan tarvitse olla aina tiettyä standardikokoa. Tarvittaessa 
erikoiskoot leikataan standardikoon arkeista (Toro 1999: 82). 
 

 
 
Kuvio 5 Paperien standardikoot (Koskinen 2001: 63) 
 
 

2.2.1 Sivumäärä 
 
Pienin painettava sivumäärä julkaisussa on kaksi sivua. Neljällä ja-
olliset sivumäärät ovat yleisimpiä, koska ne ovat turvallisia ja moni-
sivuiset, sidottavat tuotteet ovat helposti toteutettavia. Tämä on 
myös taloudellinen tapa. Sivumäärän ei kuitenkaan tarvitse olla nel-
jällä jaollinen. Monisivuisissa julkaisuissa yksi arkeista voidaan teh-
dä 6-sivuiseksi aukeamaksi, jossa on kolme sivua vierekkäin. Poik-
keavat sivumäärät ovat kuitenkin aina kalliimpia toteuttaa kuin nel-
jällä jaolliset. (Koskinen 2001: 63, 64.) 
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2.2.2 Paperin laadulliset tekijät 
 
Paperin valinnassa kannattaa kiinnittää huomiota sen opasiteettiin eli 
läpinäkymättömyyteen. Voi olla häiritsevää, jos katalogin seuraavan 
sivun kuvat ja tekstit kuultavat läpi edelliselle sivulle. Jos paperin 
opasiteetin arvo on vähintään 100, se ei ole läpikuultavaa (Koskinen 
2001: 34). Paperin väriksi voidaan valita jokin muu kuin täysin val-
koinen. Se voi olla esimerkiksi jo valmiiksi värjätty. Värillistä pape-
ria ei kuitenkaan suositella käytettäväksi painotuotteissa, joissa on 
valokuvia, sillä silloin kuvan värit eivät välttämättä toistu oikean sä-
vyisinä (Koskinen 2001: 39). Valkoisen paperin ei tarvitse olla aivan 
valkoinen, vaan se voi olla sävyltään kellertävää tai harmaata. 
 
Paperi voi olla laadultaan joko päällystettyä tai päällystämätöntä. 
Päällystetyn paperin erottaa päällystämättömästä paperin karheus. 
Päällystetyn paperin pinta tuntuu sileältä. Päällysteenä paperissa 
käytetään kivipitoista lateksia (Toro 1999: 99). Päällystetyn paperin 
etuihin voidaan lukea se, että kuvat toistuvat siinä hyvin. 
 
Päällystämätön paperi sen sijaan tuntuu karhealta. Esimerkiksi sa-
nomalehdet ja tulostuspaperi ovat päällystämätöntä paperia. Koska 
katalogeissa tuotekuvilla on yleensä suuri rooli, ei tästä syystä pääl-
lystämätöntä paperia kannata käyttää varsinkaan, jos haluaa antaa 
katalogista korkealaatuisen vaikutelman. 
 
Paperi voi olla myös eri paksuista. Paksuutta kuvataan paperin ne-
liömetripainona, g/m2 (Koskinen 2001: 34). Lehtosen, Mattilan, Vei-
lon & Ranisen (2003: 83, 84) mukaan virsikirjoissa käytettävä pape-
rilaatu on 25 g/m2 ja kopiopaperissa 80 g/m2. Kartongiksi luetaan 
paperi, jonka paksuus on yli 170 g/m2 ja pahvilla vastaava paksuus 
on 250-750 g/m2. Toro (1999: 102) mainitsee, että tuotteen paperi-
vahvuus voi vaikuttaa merkittävästi myös tuotteen postituskuluihin. 
Mitä suurempi vahvuus paperilla on, sitä enemmän se painaa. 
 
 

2.3 Painomenetelmät 
 
Yhteiskunnassa tiedon käsittely sähköisessä muodossa on viime 
vuosina kasvanut suuressa määrin. Tämä kasvu on vaikuttanut myös 
painoalaan. Digitaalinen painaminen painomenetelmänä on alkanut 
yleistyä perinteisen painamisen rinnalla. Lehtosen ym. (2003:14) 
mukaan Gamisin teettämä tutkimus paljasti, että digitaalinen paina-
minen tulee lähivuosien aikana kasvamaan 25 prosenttia. Heidän 
mielestään digitaalisen painamisen ei kuitenkaan uskota valtaavan 
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kaikkea alaa perinteisiltä tekniikoilta, vaan se tuo lisävaihtoehdon jo 
olemassaolevien tekniikoiden rinnalle. 
 

2.3.1 Offsetmenetelmä 
 

Painomenetelmistä offset on nykyisin yleisimmin käytetty menetel-
mä. Offsetemenetelmässä käytetään kahdenlaisia painokoneita; ark-
ki- ja rullapainokoneita. Rullapainokonetta kutsutaan myös nimellä 
rotaatiopainokone. Näiden kahden merkittävin ero on se, että arkki-
painokoneessa painoalustana käytetään arkkeja (Kuvio 6). Taitto, si-
donta ja puhtaaksileikkaus tehdään erikseen painamisen jälkeen 
(Koskinen 2001: 128). 
 

 
 
Kuvio 6 Arkkipainokoneen offsetyksikkö (Koskinen 2001: 123) 
 
Rotaatiokoneessa sen sijaan painoalusta, esimerkiksi paperi, tulee 
koneeseen rullasta, ja se katkaistaan sopivasta kohdasta (Pesonen & 
Tarvainen 2001: 374). Rotaatiokoneella tehtävä työ on valmis toimi-
tettavaksi sen jälkeen, kun se on saatu ajettua koneen läpi. Jälkikäsit-
tely hoidetaan samassa koneessa, jossa tuote on painettukin. (Koski-
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nen 2001: 122, 128.). Kuvassa on esitetty yksinkertaistettuna rotaa-
tiopainokoneen offsetyksikkö (Kuvio 7). 
 

 
 
Kuvio 7 Rotaatiopainokoneen offsetyksikkö (Koskinen 2001: 131) 
 
Offset-menetelmässä käytetään joko märkä- tai kuivateknologiaa ja 
Suomessa käytössä on lähes kaikkialla märkäteknologia (Koskinen 
2001: 123). Offset-koneessa väri johdetaan painopellille, joka on kä-
sitelty siten, että siinä on vettä hylkiviä ja vastaanottavia kohtia. Off-
set-menetelmässä painoväri on öljypohjaista, jolloin väri jää kiinni 
painopellin niihin kohtiin, joissa on vettä hylkivä pinta (Koskinen 
2001: 123). Painopelliltä väri siirtyy kumisylinterille ja sen kautta 
paperille. 
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2.3.2 Digitaaliset menetelmät 
 

Digitaalinen painokone on periaatteessa kuin suuri tulostin. Lehto-
nen ym. (2005: 102) mainitsevat, että kun tulostin täyttää seuraavat 
kriteerit, voidaan sitä sanoa digitaaliseksi painokoneeksi. Tulostimen 
tulostusresoluution tulee olla vähintään 600 dpi ja tulostusnopeus on 
vähintään 40 A4-sivua minuutissa. Digitaalisessa menetelmässä on 
luovuttu menetelmästä, jossa painopinta muodostettiin painolevylle 
kopioimalla se painofilmiltä (Koskinen 2001: 124). 
 
Menetelmä, jota digitaaliset painokoneet nykyään yleisimmin käyt-
tävät, on nimeltään elektrofotografia (EFG) (Lehtonen ym. 2005: 
105). Elektrofotografiassa painoalustana toimiva fotojohderumpu 
varataan sähkövarauksella tasaisesti. Tämän jälkeen LED-diodien tai 
laser-säteen avulla sähkövarausta puretaan niistä kohdista, joihin vä-
rijauheen eli toonerin ei haluta kiinnittyvän. Kun värijauhe johdetaan 
rumpuun, kiinnittyy se varauksellisiin kohtiin ja muodostaa painet-
tavan aiheen.  
 
Tooneri eroaa painoväristä. Kiinteät toonerit ovat itsessään magneet-
tista väriainetta tai niiden seassa on kehitettä, joka koostuu metalli-
hiukkasista, joiden avulla värilliset muovirakeet siirtyvät fotojohde-
rummulle (Lehtonen ym. 2005: 109). Kuva siirtyy rummulta paperil-
le sähkövarauksen avulla ja lopuksi se sulatetaan paineen ja lämmön 
avulla kiinni paperiin. (Koskinen 2001: 154.) 
 
Digitaalinen painaminen on mahdollistanut pienten painosmäärien 
tuottamisen. Offsetpainatuksessa tuotteen kappalehinta laskee sitä 
mukaa, mitä suurempi painomäärä on. Koska digitaalisessa painami-
sessa kustannukset eivät muutu painoksen kasvaessa, vaan painetut 
kappaleet ovat samanhintaisia, soveltuu digitaalinen painaminen off-
setpainamista paremmin pienten määrien painamiseen. Vahvuudeksi 
voidaan myös lukea se, että painomäärä voi olla juuri sen suuruinen, 
kuin sillä hetkellä on tarve. Digitaalinen painaminen ei vaadi vä-
himmäismäärää painamiseen, jota offsetpainamisessa jälkikäsittely-
laitteet tarvitsevat. (Lehtonen ym. 2005: 17, 25.) 
 
Jos tuote on määrä julkaista toisella paikkakunnalla tai jopa toisessa 
maassa, kuljetuskustannuksissa voidaan säästä hajauttamalla paina-
mista. Tietoverkon kautta painettava tuote voidaan siirtää nopeasti 
tiettyyn painotaloon, jossa se voidaan tulostaa lähempänä määrän-
päätä. 
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2.4 Typografia 
 
Typografia voidaan joskus sekoittaa siten, että sen luullaan tarkoit-
tavan vain käytettävää kirjasinlajia. Typografia käsittää kyllä käytet-
tävän kirjasinlajin, mutta kokonaisuudessaan se tarkoittaa koko pin-
nan painoasua. Siinä huomioidaan kaikki asiat, jotka liittyvät tekstin, 
kuvien ja tilan käyttöön. (Toikkanen 2003: 33.) 
 
 

2.4.1 Kirjaintyylit ja tekstin pistekoko 
 

Kirjaimet jaetaan erilaisiin ryhmiin sen mukaan, millaisia ne ovat 
muodoiltaan. Koskinen (2001: 67) kertoo, että eri maissa on eri ta-
vat, joilla tämä ryhmittely tehdään ja Suomessa käytetään Olof 
Erikssonin laatimaa luokitusta. Hänen mukaansa Erikssonin tapa on 
jakaa kirjaintyypit neljään eri ryhmään: goottilaiset, egyptienne-
muodot, antiikvat, ja groteskit. Alla olevasta kuviosta näkee, miten 
eri kirjaintyypit eroavat toisistaan (Kuvio 8). 
 

 
 
Kuvio 8 Erilaisia kirjaintyylejä (Monotype Imaging 2007) 
 
Goottilaista kirjaintyyliä on esimerkiksi fraktuura. Sen muoto vastaa 
tasateräisellä piirturilla tehtyä jälkeä (Koskinen 2001: 68). Goottilai-
silla kirjaintyyleillä voi nähdä kirjoitetun esimerkiksi vanhat raama-
tut. Se on vaikealukuista ja siksi sitä ei kannata käyttää leipätekstinä. 
Egyptienne-kirjaintyylin kirjaimissa on vahvat päätteet ja kaikki kir-
jaimen osat ovat samanvahvuisia (Koskinen 2001: 69). Egyptienne-
kirjasimia ovat esimerkiksi Memphis ja Beton. 
 
Antiikva-tyylin kirjaimet ovat päätteellisiä tai päätteettömiä ja ne 
eroavat egyptienne-muodoista siten, että kirjaimen osat ovat erivah-
vuisia (Koskinen 2001: 69). Antiikvamuotoja neuvotaan käyttämään 
julkaisuissa leipä- eli sisältötekstinä. Antiikvat ovat helppolukuisia, 
sillä kirjaimet sopivat hyvin toistensa viereen ja kuljettavat näin kat-
setta eteenpäin (Toikkanen 2003: 40). Antiikvoja ovat esimerkiksi 
Times New Roman ja Garamond. 
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Vaikka groteskit, toiselta nimeltään sans-serif, eivät sovi leipäteks-
tiksi niin hyvin kuin antiikvat, niitä voi silti käyttää otsikoissa 
(Toikkanen 2003: 40). Groteskit ovat muodoiltaan päätteettömiä. 
Päätteettömät groteskit ja antiikvat erottaa toisistaan siten, että gro-
teskien kirjainten osat ovat tasavahvoja kun taas antiikvoissa ne ovat 
erivahvuisia. Groteskeja ovat esimerkiksi Arial ja Avant Garde. 
 
Erikssonin luokitukseen eivät kuulu erilaiset koriste-, fantasia- kä-
sialakirjaimista muodostuvat ryhmät. Näiden ryhmien kirjaimet 
eroavat toisistaan niin paljon, ettei niitä ole sisällytetty Erikssonin 
ryhmittelyyn. (Koskinen 2001: 69.) 
 
Otsikkoteksti kannattaa muotoilla siten, että se näkyy hyvin ja ker-
too myös, mistä kyseisellä sivulla on kyse. Toikkasen (2003: 34) 
mukaan otsikoissa voi olla hyvä käyttää selvästi eri kirjasinlajia, 
kuin leipä- tai kuvatekstissä. Hän kertoo, että tätä nimitetään typo-
grafiseksi muotokontrastiksi. Koskinen (2001: 78) huomauttaa, että 
otsikoissa kannattaa ottaa huomioon se, että jos otsikon kirjainten 
pistekoko on 14 tai suurempi, kannattaa kirjainten etäisyyttä toisiin-
sa pienentää siten, että teksti näyttää hyvältä. Hänen mielestä tällä 
saa kauniimman lopputuloksen, vaikkakin sille, kuinka paljon kir-
jaimia tulee lähentää, ei ole mitään tarkkaa ohjetta tai arvoa. 

 
Leipäteksti on yleensä lehdissä, esitteissä ja kirjoissa kooltaan 10-11 
pistettä, riippuen käytettävästä kirjasinlajista. Otsikoiden pistekooksi 
valitaan yleensä yli 12 pisteen koko. Kyseessä oleva julkaisu asettaa 
tälle tietysti jonkinlaiset rajat. Esimerkiksi sanomalehdissä pistekoko 
voi olla 50-60 pistettä. (Toikkanen 2003: 33.) 
 
Kuvateksti kannattaa lisätä kuviin aina, jos kuvalla on tarkoitus an-
taa jotakin informaatiota, eikä vain olla sommitteluun kuuluva sisäl-
töelementti. Kuvateksteissä käytettävä pistekoko tulee olla pienempi 
kuin leipätekstissä ja kirjaintyyppi voi olla esimerkiksi kursiivi 
(Toikkanen 2003: 33.). Kuvatekstit kannattaa sijoittaa myös selvästi 
kyseessä olevien kuvien läheisyyteen, jotta lukija tietää, mihin kuva-
tekstillä viitataan. Riippuen katalogin yleisilmeestä, kuvateksti on 
hyvä sijoittaa joka kuvan viereen samaan paikkaan kuin muissa ku-
vissa. Tämä luo yhtenäisemmän ilmeen katalogille. Jos katalogin ei 
alun perinkään tule olla selvän kaavamainen ja järjestelmällinen, voi 
kuvatekstejä hieman poikkeavasti asettelemalla tuoda mukavaa lisää 
sommitteluun. Kuvatekstien lisäämistä puoltaa sekin, että Koskisen 
(2001: 79) mukaan kuvatekstit luetaan ennen leipätekstiin tutustu-
mista. 
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2.4.2 Sommittelu 
 

Hyvä sommittelu antaa lukijalle järjestelmällisen ja siistin kuvan 
julkaisusta. Julkaisulle kannattaa suunnitella ensin yleisilme, jota 
kaikki sivut noudattavat (Toikkanen 2003: 39). Kun kaikkien sivujen 
pohja on keskenään yhtenäinen, vaikuttaa julkaisu paljon rauhalli-
semmalta, kuin että jokainen sivu olisi täysin erilainen kuin edelli-
nen. Kuvien osalta Toikkanen (2003: 38) suosittelee, että ne tulisi 
sommitella avautumaan julkaisun keskustaan päin, ja jos kuvassa on 
henkilö, tulee kuva sovittaa sivulle niin, että henkilö ei katso ulos si-
vulta. 
 
Sommittelussa voi käyttää apunaan erilaisia geometrisiä kaavoja, 
esimerkiksi tasapainolinjaa ja kultaista leikkausta. ”Tasapainolinjan 
sijainti määräytyy siten, että linjan alapuolinen osa on suunnilleen 
sama kuin paperin tai painopinnan leveyden ja korkeuden suhde.” 
(Toikkanen 2003: 39.) Tasapainolinja sijaitsee siis hieman ylempänä 
kuin paperin keskikohta. Kultainen leikkaus saadaan määriteltyä 
samalla, kun määritellään paperin tasapainolinja. 
 
Kultainen leikkaus on 2500 vuotta vanha geometrinen kaava, jota 
käytetään kaikenlaisessa sommittelussa apuna. Katse pyrkii aina en-
siksi hakeutumaan kultaiseen leikkaukseen. Kultaisessa leikkaukses-
sa pienemmän osan suhde suurempaan on sama kuin suuremman 
suhde molempien yhteiseen pituuteen. Paperikoko A4 on mittasuh-
teiltaan lähellä kultaista leikkausta. (Toikkanen 2003: 39.) 
 
 

2.5 Kuva-aineisto 
 

Jokaiseen katalogiin tulee jossakin määrin kuvia. Varsinkin Hoo-
Hoo Oy:n katalogissa, jossa pääosa on kuvilla, ei niinkään tekstillä. 
Kun ihminen näkee sivulla tekstiä ja kuvia, huomio kiinnittyy lähes 
aina ensin kuvaan. Koskinen (2001: 80) kertoo, että ihminen reagoi 
aina näkemäänsä visuaalisia asioita analysoivalla, aivojen oikealla 
puoliskolla. Hän jatkaa, että loogisia asioita käsitellään vasta sen jäl-
keen vasemmalla aivopuoliskolla. Esimerkiksi teksti kuuluu näihin 
loogisiin asioihin ja huomioarvoltaan kuvan kanssa kilpailevat vain 
pääotsikot. 
 
Koskisen (2001: 81) mukaan kuvan huomioarvotekijät voidaan lait-
taa seuraavaan järjestykseen: 
 
1. 1-2-vuotiaat lapset, 
2. aikuiset, 
3. eläimet, 
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4. kasvit, 
5. maisemat, 
6. tuotteet. 
 
Kuva-aineiston hankinnalle rajat yleensä määrittää katalogin tekoon 
varattu budjetti. Ammattikuvaajaa käytettäessä joutuu tietysti varau-
tumaan eri kustannuksiin, kuin jos ottaa itse kuvat. Omia kuvia otet-
taessa täytyy olla jonkinlaista tietoa ja taitoa valokuvauksesta ja tar-
vittavat laitteet. 
 
Täytyy kuitenkin muistaa, että ammattikuvaajan tuotokset ovat täy-
sin valmiita käytettäväksi sen jälkeen, kun ne saadaan kuvaajalta. 
Mainoskuvaajalla jopa 70 % kuvan tuottamiseen liittyvästä ajasta 
kuluu kuvien käsittelyyn (Kolari 2006: 11). Tämä kannattaa pitää 
mielessä myös silloin, kun kuvia vasta suunnitellaan otettavan. Ku-
vaajan kanssa voi sopia, että kuville ei tehdä jälkikäsittelyä syystä tai 
toisesta. Kolarin (2006: 12) mukaan normaalisti kuvat jälkikäsitel-
lään, jollei toisin sovita. 
 
Riippuen kuvankäsittelyn vaativuudesta, voi kuvia myös itse korjail-
la kuvankäsittelyohjelman avulla. Jos uskoo, että kykenee tekemään 
kuvalle tarvittavat säädöt, voi tässä tapauksessa sijoittaa jälkikäsitte-
lyyn budjetoidut varat johonkin muuhun työvaiheeseen. Kuvaan tu-
lisi tehdä muun muassa värien korjausta, terävöittämistä, mahdolli-
sesti rajausta sekä valita käytettävä työprofiili kuvalle. 
 
Kuvia saa myös tilattua kuvatoimistoilta, -pankeilta ja -arkistoista 
(Koskinen 2001: 81). Kuvatoimistojen kuvia voi katsella niiden jul-
kaisemista kuvaluetteloista. Nämä ovat kuitenkin jo olemassa olevia 
kuvia, jotka eivät välttämättä sovi siksi juuri tiettyä katalogia varten. 
Kuvia sisältäviä CD-ROM-levyjä saa tilattua kuvatoimistojen sivuil-
ta heidän määrittelemiä maksuja vastaan. Kuvia voi saada katsotta-
vaksi ja parin viikon kuluessa pitää päättää, tilaako kuvia vai ei (To-
ro 1999: 21). 
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3 Kuvankäsittely 
 

Kuvia joutuu aina käsittelemään jotenkin, ennen kuin ne saadaan lai-
tettua katalogiin halutun näköisinä. Vaikka kuvat olisi ottanut am-
mattilainen, voi olla, että niille joudutaan vielä tekemään jonkinlais-
ta rajaamista, jotta ne saadaan näyttämään hyvältä muiden sisältö-
elementtien kanssa. 

 
 

3.1 Värienhallinta 
 

Elektronisissa näyttölaitteissa värit toistuvat erilaisina, vaikka kyse 
olisi kahdesta saman valmistajan laitteesta. Tämän voi parhaiten to-
deta kodin elektroniikkaa myyvässä yrityksessä, jossa on monta te-
levisiota esillä useassa rivissä. Kaikissa televisioissa värit eroavat 
toisistaan jonkin verran. Jos värienhallinta ei ole kohdallaan, tulos-
timen tulostamassa kuvassa värit näyttävät erilaisilta, kuin tietoko-
neen näytöllä.  
 
International Color Consortium (ICC) on laite- ja ohjelmistovalmis-
tajien perustama yhteisö, joka laati laiteriippumattoman ICC-stan-
dardin vuonna 1993. ICC-standardin mukaan jokaisella laitteella on 
oma laiteprofiilinsa, joka kertoo, kuinka hyvin laite pystyy esittä-
mään värejä. Värienhallintaa käytettäessä jokaiseen kuvatiedostoon 
on sisällytetty ICC-profiili. Värit pystytään toistamaan kaikkien pro-
filoitujen laitteiden ja ICC-yhteensopivien sovellusten välillä mah-
dollisimman tarkasti. (Lukkarila 2000: 226). 
 
Näin värinhallinnan avulla varmistetaan, että kuvat näyttävät mah-
dollisimman samalta työkulun jokaisessa vaiheessa jokaisella lait-
teella (Keränen ym. 2005: 120). Värinhallinnalla ei kuitenkaan saada 
värejä täysin samanlaisiksi kahden laitteen välillä. 
 
 

3.1.1 Värienhallintajärjestelmä 
 
Oletetaan, että kuva kulkee esimerkiksi digitaalikameran kautta ku-
vankäsittelyohjelmaan ja siitä tulostimeen. Jokaisessa vaiheessa vä-
rienhallintajärjestelmä (CMS, Color Management System) auttaa 
säätämään värejä siten, että ne näyttäisivät mahdollisimman yhden-
mukaisilta eri laitteiden ja ohjelmistojen välillä. (Lukkarila 2000: 
226, 227). 
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Tietokoneissa käytettävät värienhallintajärjestelmät ovat erilaisia 
riippuen siitä, mikä käyttöjärjestelmä on kyseessä. Värienhallinta-
järjestelmä, joka voi olla käytössä Windows- ja MacOS-käyttöjär-
jestelmässä, on Adobe CMS. Käyttöjärjestelmään sidotuista värien-
hallintajärjestelmistä Macintosh-koneissa käytetään Applen Color-
Sync- sekä LinoCMM -järjestelmää. Windows-koneissa käytössä on 
vastaavasti Microsoft Windows ICM 2.0 ja Kodak Digital Science 
ICC CMS. (Lukkarila 2000: 226.) 
 
 

3.1.2 Näytön profilointi 
 
Värienhallinta aloitetaan kalibroimalla näyttö. On hyvä, että näyttö 
on ollut päällä vähintään puoli tuntia, sillä silloin se on lämmennyt 
ja värit ovat aidoimmillaan. Työhuoneessa tulisi olla myös sellainen 
valaistus, joka siellä on normaalistikin. (Kainulainen 2006: 203.) 
Kalibroinnissa käytetään niin sanottua gamma-korjausta. Tämä tar-
koittaa, että  valoisten kohtien korostuessa liikaa se korjataan koros-
tamalla tummia kohtia kuvaputkella (Rinne 2006: 59).  
 
”Säädöillä asetetaan näytön tummin ja vaalein kohta riittävän kauas 
toisistaan, korjataan näytön tuottama harmaa mahdollisimman 
neutraaliksi, ja säädetään näytön gamma-korjaus juuri tietynlaisek-
si.” (Rinne 2006: 60.) 

 
Ennen kalibraatio-ohjelman avaamista, kannattaa näytön valikosta 
muuttaa värilämpötila arvoon 6500 K. Kalibraatio suoritetaan aja-
malla siihen käytettävä ohjelma. Ohjelmassa käydään vaihe vaiheel-
ta kalibraatioon liittyvät asiat. Gamma-arvoksi kannattaa laittaa sitä 
kysyttäessä 2,2. Nykyään tätä arvoa suositellaan käytettäväksi sekä 
Windows- että Macintosh-koneissa. Gamman säätö kertoo näy-
tönohjaimelle, miten keskisävyjä pitää säätää (Evening 2005: 99). 
 
Kalibroinnin voi suorittaa kolmella tavalla. Markkinoilla on myyn-
nissä kalibrointiin tarkoitettuja sensoreita, jotka kiinnitetään näyt-
töön ja säädöt asetetaan sopiviksi sensorin mukana tulevan sovelluk-
sen avulla. Sensorin avulla saa luotettavan ja laadukkaan tuloksen, 
mutta siihen soveltuvat laitteet ovat kalliita; hinta on noin sadasta 
eurosta ylöspäin. 
 
Toinen keino on käyttää Photoshopin mukana tulevaa Adobe Gam-
ma-ohjelmaa, joka löytyy Ohjauspaneelista. Macintosh-koneissa tar-
koitukseen soveltuu käyttöjärjestelmän oma ohjelma. ColorSync        
-ohjelmaa käytetään Mac OS X:ssä, ja Mac OS 9.x -järjestelmässä 
kolmansien osapuolten kalibrointiohjelmistoa (Kainulainen 2006: 
203). Paint Shop Pro:ssa kalibroinnin voi tehdä valikosta File>Color 
Management >Monitor Calibration. Tämän keinon käyttö saattaa 
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houkuttaa sillä, että se on ilmainen. Silmämääräinen kalibrointi hä-
viää kuitenkin aina sensorilla tehdylle. Tämän vuoksi täytyy muis-
taa, että jos haluaa luotettavan ja parhaan mahdollisen lopputulok-
sen, kannattaa todellakin panostaa laadukkaaseen kalibrointipaket-
tiin. 
 
Näytön voi kalibroida myös käyttämällä laitteen tehdasasetuksia ja 
valmistajan niille tekemiä profiileja. Tätä ei kuitenkaan suositella, 
sillä nämä asetukset ovat suuntaa-antavia. (Hintikka 2006.) 
 
Joskus kalibrointi ja profilointi mielletään samaksi asiaksi. Kalib-
roinnilla laitteen toimintaa muutetaan sen omilla säätimillä. Profi-
lointi-vaihe seuraa tätä ja siinä luodaan profiilitiedosto, joka kuvaa, 
kuinka laite toistaa värejä (Hintikka 2006). 
 
Monitorin kalibraatio tulisi suorittaa kuvaputkinäytöillä (CRT) parin 
viikon välein ja nestekidenäytöillä (LCD) pari kertaa vuodessa (Kai-
nulainen 2006: 203). Evening:n (2005: 99) mukaan kuvaputkinäy-
töillä aika, jolloin se vielä toistaa värit luotettavasti, on noin kolme 
vuotta. Hän myös kertoo, että putkinäytön käyttöikää voi pidentää 
käyttämällä näytönsäästäjää ja pienentämällä näytön kuvan leveyttä 
ja korkeutta siten, että reunoilla näkyy mustaa noin puoli senttimet-
riä. 
 
 

3.1.3 Työprofiilin valinta 
 
Kun kuvia käsitellään kuvankäsittelyohjelmalla, valitaan yleensä jo-
kin työprofiili, jossa kuvia käsitellään. Työprofiiliksi valitaan yleen-
sä joku standardoitu väritila, sRGB tai Adobe RGB. Painotuotteita 
varten on myös eri CMYK-profiileja, esimerkiksi Euroscale Coated 
ja Euroscale Uncoated, ensimmäinen on päällystetylle paperille ja 
jälkimmäinen päällystämättömälle. 
 
Vaikka näytölle on tehty oma profiilinsa, ei sitä kuitenkaan kannata 
käyttää työprofiilina, sillä sen väriskaala voi olla suppeampi kuin 
standardoitujen profiilien. Rinteen (2006: 60) mukaan laitetta varten 
tehty profiili on myös vaikeampi tehdä uudestaan, jos kuvasta huka-
taan profiilitiedot tai jos tieto muuttuu. 
 
Työprofiili otetaan Photoshopissa käyttöön valitsemalla Edit/Color 
Settings. Working Spaces -kohdasta valitaan käytettävä RGB- ja 
CMYK-väritila. Adobe InDesign -ohjelmassa työprofiilit asetetaan 
valikosta Edit>Colour Settings. Working Spaces -kohtaan valitaan 
RGB- ja CMYK-väritila. 
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Adobe RGB -väritilaa neuvotaan käyttämään, jos kuvia on tarkoitus 
lähettää painoon tai niitä on tarkoitus tulostuttaa kuvapalveluissa. 
Tätä työtilaa suositellaan käytettäväksi sellaisten RGB-kuvien 
muokkauksessa, jotka muunnetaan painoa varten CMYK-tilaan 
(Kainulainen 2006: 207). CMYK-tilaan muutettavien kuvien muok-
kaamiseen sopii myös ColorMatch RGB -työtila, sillä se on lähem-
pänä painokoneiden käyttämää värialuetta (Kelby 2006: 129). 
 
Toinen standardiksi muodostunut väritila on sRGB. Sen koko nimi 
on sRGB IEC61966-2.1, ja sen väriavaruus on suppeampi kuin 
Adobe RGB:n (Kainulainen 2006: 207). Tämä väriavaruus on hyvä 
valinta, jos kuvia on tarkoitus käyttää Internetissä, joten siksi se so-
veltuu hyvin katalogiin, joka on tarkoitus julkaista myös verkossa. 
Tällöin katalogista kannattaa tehdä kaksi eri versiota. Verkkojul-
kaisuksi tarkoitettuun katalogiin tulevia kuvia tulee käsitellä sRGB   
-väritilassa ja painotuotteeksi tarkoitettuja Adobe RGB -väritilassa. 
 
CMYK-profiiliksi kannattaa valita Europe ISO Coated Fogra27. Se 
sopii Kainulaisen (2006: 207) mukaan eurooppalaisille painotaloille. 
Kirjapainoilta voi tiedustella myös heidän käyttämiään väriprofiileja. 
Painon WWW-sivuilta tai sähköpostilla tilattaessa saa ICC-profiili-
tiedoston, joka tallennetaan käyttöjärjestelmästä riippuen tiettyyn 
kansioon. Tämän jälkeen profiilin voi valita esimerkiksi Photosho-
pin Color Settings -asetuksissa. 
 
 

3.1.4 CIE Lab -väriavaruus 
 
Comission Internationale d’Eclairage (CIE) esitti vuonna 1931 mal-
lin kansainväliseksi värien mittausmenetelmästandardiksi. Tähän 
malliin pohjautuva, laitteistoriippumaton CIE Lab -väriavaruus ni-
mettiin ja vahvistettiin vuonna 1976. CIE Lab:ssa värit esitetään 
kolmen komponentin, kirkkauden ja kahden kromaattisen kom-
ponentin, avulla. Kromaattisesta komponentista a sisältää värit vih-
reästä punaiseen ja komponentti b värit sinisestä keltaiseen. Kirkka-
us L voi saada arvon 0   -100, missä arvo 0 on musta ja arvo 100 on 
valkoinen. (Lukkarila 2000: 226.) 
 
Koska CIE-väriavaruus pitää sisällään 36 miljoonaa värisävyä, sitä 
voidaan käyttää apuna muutettaessa värejä väriavaruudesta toiseen. 
CIE Lab:n puitteissa voidaan esittää kaikki väriavaruudet ja se pys-
tyy esittämään jopa ihmissilmän erottamat värisävyt. Esimerkiksi 
RGB- ja CMYK-väritilat eivät sisällä läheskään yhtä monta vä-
risävyä kuin CIE Lab (Kuvio 9). CIE Lab -avaruutta käytetäänkin 
värejä muutettaessa viiteavaruutena värien esittämiselle. (Lukkarila 
2000: 228.) 
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Kuvio 9 CIE Lab -väriavaruus käsittää RGB- ja CMYK-väriavaruu-
den värisävyt (Kleper 2001:b) 
 
 

3.2 Resoluutiot 
 

Bittikarttakuvat koostuvat eri värisistä kuvapisteistä. Kuvassa nämä 
pisteet ovat niin tiheässä, että ihmissilmä ei erota enää yksittäisiä 
pisteitä, vaan ne muodostavat kuvan. Resoluutio tarkoittaa käytän-
nössä sitä, kuinka tiheästi näitä pisteitä on kuvassa. Mitä tiheämmäs-
sä pisteet ovat, sitä suurempi on kuvan resoluutio ja sitä enemmän 
yksityiskohtia kuvassa voi olla. (Keränen ym. 2005: 84.) 
 
Kuvan resoluutio ilmoitetaan yleensä pikseleiden määränä suhteessa 
tuumaan. Se lyhennetään muotoon ppi (pixels per inch). Kuvan reso-
luution suurentaminen vaikuttaa kuvan kokoon siten, että kun reso-
luutio kaksinkertaistuu, kuvan tiedostokoko nelinkertaistuu (Kainu-
lainen 2006: 17). 
 
Kuvan mittasuhteet sen sijaan ilmoitetaan, kuinka monta pikseliä 
kuvassa on vaakasuunnassa ja kuinka monta pystysuunnassa. Kuvan 
koko voi olla esimerkiksi 800 x 600 pikseliä. Tällöin se on 800 pik-
seliä leveä ja 600 korkea. Tätä kokoa sanotaan kuvan pikselikooksi. 
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3.2.1 Rasterointi 
 

Se, miten monta mustepistettä tulostin tulostaa tuumaa kohden, mää-
rittelee sen tulostustarkkuuden. Tätä tarkkuutta kuvataan lyhenteellä 
dpi (dots per inch). Tulostimet voivat tulostaa vain yhden kokoisia ja 
samanvärisiä mustepisteitä. Näin ollen värit ja sävyt saadaan kuvaan 
siten, että mustepisteistä muodostetaan eri kokoisia rasteripisteitä 
käyttämällä neljää mustetta painamisessa (Keränen ym. 2005: 86). 
Rasteripisteet koostuvat siis useista eri mustepisteistä (Kuvio 10). 
Kuvan tummemmille alueille painetaan suurempia rasteripisteitä ja 
vastaavasti vaaleammille pieniä rasteripisteitä. 
 

 
 
Kuvio 10 Rasteripiste ja tulostimen mustepiste (Keränen ym. 2005) 
 
Kuvan tarkkuutta tulosteessa määrittää se, kuinka monta rasteripis-
tettä kuvassa on tuumaa kohti. Tätä arvoa sanotaan linjatiheydeksi ja 
sitä kuvataan lyhenteellä lpi (lines per inch). Digitaalisen kuvan re-
soluutio tulee olla kaksinkertainen linjatiheyteen nähden (Kainulai-
nen 2006: 17). 
 
Painotaloissa osataan yleensä auttaa epäselvissä asioissa ja yleisenä 
nyrkkisääntönä voitaneen sanoa, että resoluutiolla 300 ppi saa hyvän 
näköisiä kuvia kirjapainosta. 
 
 

3.2.2 Sopiva resoluutio 
 
Internetiin laitettavien ja näytöltä katseltavien kuvien resoluutio tuli-
si olla 72 ppi. Koska useimpien näyttöjen maksimiresoluutio on 72 
ppi, vie tätä suurempi resoluutio vain turhaa tilaa ja hidastaa kuvien 
latautumista.  
 
Painoon lähetettävien kuvien resoluutio kannattaa asettaa vähintään 
arvoon 300 ppi. Sanomalehdissä resoluutio on n. 130-170 ppi. Tie-
tokoneen teho kuitenkin antaa loppujen lopuksi rajat suurien kuvien 
muokkaukselle. Lisäksi, jos resoluutio on yli 300 ppi, kuva on tar-
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kempi ja yksityiskohtaisempi, mutta yleensä ihmissilmä ei huomaa 
tätä eroa. 
 
 

3.3 Kuvan terävöittäminen 
 

Kuvien terävöittäminen tarkoittaa sitä, että ”kuvan vierekkäisten pik-
selien kontrastia lisätään” ja näin kuvan sisältämää epäterävyyttä 
korjataan (Kainulainen 2006: 99.) Kun katalogiin halutaan ottaa ku-
via itse, kannattaa kuvien terävöittäminen, oli kamera sitten edulli-
sempi digipokkari tai monipuolinen järjestelmäkamera. Evening 
(2005: 178) mainitsee muutamia asioita, jotka vaikuttavat kuvan te-
rävyyteen: kameran objektiivi, filmin valinta, digikameran kennon 
laatu ja kennon pikselimäärä. Hänen mukaan kuvia tulisikin terävöit-
tää aina juuri ennen kuin kuvat menevät painoon.  
 
Katalogia tehdessä kuvia ei kuitenkaan lähetetä heti tulostettaviksi, 
vaan ne liitetään kuvankäsittelyn jälkeen osaksi katalogia. Kuvankä-
sittelyssä olisikin hyvä omaksua sellainen tapa, että tekee kaikki kor-
jailut aina samassa järjestyksessä. Esimerkiksi värien säädön jälkeen 
terävöittää kuvan. Näin ollen ei tarvitse aina muistella, mitä on vii-
meksi tehnyt ja voi minimoida sitä riskiä, että esimerkiksi terävöittää 
kuvan toistamiseen. Kainulainen (2006: 99) suosittelee terävöittämi-
sen tekemistä kaiken muun käsittelyn jälkeen, juuri ennen tallenta-
mista. Hän suosittelee myös terävöityksen tekemistä kuvankäsittely-
ohjelmassa 100 % näkymässä, jolloin vaikutuksen näkee selvästi. 
Terävöittämiseen ei ole annettu mitään täysin absoluuttisia arvoja, 
joita tule aina käyttää. Lopputulos on viime kädessä kuvankäsitteli-
jän oma näkemys siitä, mikä näyttää hyvältä. 
 
Yleisin tapa terävöittää kuvia on käyttää Epäterävä maski -komentoa 
(Unsharp Mask). Photoshopissa komento valitaan Filter>Sharpen> 
Unsharp Mask. Avautuvassa valintaikkunassa voi muuttaa kuvaan 
kohdistuvan terävöityksen määrää (Amount), sädettä (Radius) ja ta-
soa (Threshold) (Kainulainen 2006: 100). Amount-arvo kertoo, 
kuinka paljon kuvaa terävöitetään. Arvoksi kannattaa asettaa luku 
100-300 % väliltä, riippuen käsiteltävästä kuvasta ja halutusta loppu-
tuloksesta. Radius-arvoksi voi kokeilla lukuja 0,8-1,5. Radius-
arvolla muutetaan terävöityjen ääriviivojen paksuutta, ja vaikutetaan 
kuvan kontrastiin. Threshold-arvo määrää, mitkä pikselit terävöite-
tään ja kuinka rakeinen kuva on. Sopiva arvo on väliltä 0-10. Kata-
logiin tarkoitettuja kuvia kannattaa terävöittää hieman enemmän 
kuin mitä tarvetta on. Terävyyttä nimittäin menetetään jonkin ver-
ran, kun katalogi tulostetaan kirjapainossa. (Evening 2005: 178.) 
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3.4 Värien säätö ja korjaus 
 

Joistakin itse ottamista kuvista huomaa heti, tarvitseeko kuvan väre-
jä säätää. Kuva voi olla yli- tai alivalottunu ja alue, jonka pitäisi oi-
keasti olla valkoinen, saattaa näyttää punertavalta tai sinertävältä. 
Värien säätöön ja korjailuun on Photoshopissa olemassa automaatti-
sia komentoja, mutta niitä voi myös korjailla manuaalisesti. Auto-
maattiset värinkorjausmenetelmät löytyvät Image>Adjustments        
-valikosta. Automaattiset korjailut saattavat toimia joissakin kuvissa 
erittäin hyvin, mutta yleensä manuaalisesti korjaamalla saa par-
haimman lopputuloksen. 
 
Värien säätäminen käsin tapahtuu parhaiten käyttämällä joko Tasot- 
tai Käyrät-komentoa. Se kumpaa tapaa haluaa käyttää, riippuu pit-
kälti omista mieltymyksistä. Kummallakin tavalla on kuvankäsitte-
lyn kannalta melkein samanlainen lopputulos (Kainulainen 2006: 
236). 
 
 

3.4.1 Vaalean ja tumman pisteen asettaminen 
 
Värien säätäminen kannattaa aloittaa vaalean ja tumman pisteen sää-
tämisellä, sillä varsinkin painettavaksi tarkoitetuissa kuvissa tällä on 
suuri merkitys. Internetiin tarkoitettujen kuvien kohdalla ei vaaleaa 
ja tummaa pistettä tarvitse välttämättä säätää. Kuvan vaalea piste 
määrittää sen, kuinka vaalea on kuvan vaalein piste. Vaalean pisteen 
tulisi olla hieman tummempi kuin 100 % valkoinen, mutta ei kuiten-
kaan harmaa. Jos vaaleaksi pisteeksi määrittää täysin valkoisen koh-
dan, saattavat sen sävyiset kohdat palaa puhki. (Kainulainen 2006: 
232.) 
 
Tumman pisteen määrittämisessä valitaan kohta, joka on hieman 
vaaleampi kuin täysin musta. Tumman pisteen tulee kuitenkin olla 
sellainen, ettei se näytä harmaalta. Jos tumma piste on asetettu ar-
voon 0 %, on se silloin täysin sävytön musta. Kuvasta voi myös etsiä 
neutraalin harmaan kohdan, joka on kuvan harmaa piste eli gamma. 
Harmaan kohdan asettaminen ei ole välttämätöntä mutta yleensä se 
parantaa kuvan värisävyjä. (Kainulainen 2006: 232, 233.) 
 
Vaalean ja tumman pisteen määrittämiseksi avataan Photoshopissa 
Image>Adjustments>Levels (Tasot) (Kuvio 11). Avautuvassa ikku-
nassa kaksoinapautetaan valkoista pipettiä (1), joka avaa Värimuok-
kain-ikkunan (Color Picker). Ikkunassa syötetään L-kenttään arvo 
väliltä 95-98 (Kuvio 12). Tämä määrittää kuinka valkoinen on kuvan 
vaalein arvo. Ikkuna suljetaan painamalla OK. Sama toistetaan kak-
soisnapauttamalla mustaa pipettiä (2). Värimuokkain-ikkunassa L-
kenttään syötetään arvo väliltä 5-15, joka määrittää kuvan mustim-
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man pisteen värisävyn. Muutos hyväksytään painamalla OK-
painiketta. (Kainulainen 2006: 232, 233.) 
 

 
 
Kuvio 11 Levels-valikko (Photoshop 7.0) 
 

 
 
Kuvio 12 Värinmuokkain-ikkuna, johon syötetään kuvan vaalein ja 
tummin arvo. (Photoshop 7.0) 
 
Kun Tasot-ikkuna on vielä auki, valitaan valkoinen pipetti ja napau-
tetaan kuvan kirkkainta kohtaa. Tällä asetetaan kuvan vaalein kohta. 
Seuraavaksi määritetään kuvan tummin kohta valitsemalla musta pi-
petti ja napauttamalla kuvan tumminta kohtaa. Jos kuva näyttää eri-
koisen sävyiseltä, kannattaa napauttaa pipeteillä joissakin toisissa 
kohdissa, kunnes lopputulos on toivotun näköinen. Harmaata pipet-
tiä käyttämällä voi kuvaan määrittää harmaan pisteen. Harmaalla pi-
petillä napautetaan kohtaa, joka näyttää neutraalilta harmaalta. (Kai-
nulainen 2006: 233.) 
 
Kuvaa kannattaa tämän jälkeen vielä hienosäätää Tasot-ikkunan 
mustaa, valkoista ja harmaata liukusäädintä säätämällä. Harmaa liu-
kusäädin säätää kuvan keskisävyjä, musta tummia sävyjä ja valkoi-
nen vaaleita sävyjä. Kun kuva näyttää korjatulta, painetaan OK-
painiketta. (Kainulainen 2006: 234.) 
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3.4.2 Värin korjaaminen 
 

Tasot-ikkunassa voi pudotusvalikosta valita tietyn värikanavan, jolla 
värejä korjataan. Jokaiselle värikanavalle voi määrittää erikseen vaa-
lean ja tumman pisteen. Jokaisella värikanavalla voi erikseen säätää 
myös liukusäätimiä. Gammasäätimen vetäminen jollakin kanavalla 
lisää tai vähentää väriä. (Kainulainen 2006: 235.) 
 
Jos kuva on punertava, tulee vihreätä väriä lisätä kuvaan, koska vih-
reä on punaisen komplementti- eli vastaväri. Oheisesta väriympyräs-
tä näkee, kuinka väriympyrä on muodostettu (Kuvio 13). Punainen, 
sininen ja keltainen ovat päävärit. Niiden välissä olevat välivärit 
saadaan muodostettua sekoittamalla päävärejä keskenään. 
 

 
Kuvio 13: Väriympyrä (Opetushallitus 2005) 
 
Photoshopin Image>Adjustments>Variations (Variaatiot) -komen-
nolla on helppo opetella värien korjailua. Variaatiot-ikkunassa vä-
rejä voi korjata lisäämällä vastaväriä. Käytännössä tämä tapahtuu 
napauttamalla eri värisävyllä väritettyjä, alkuperäisen kuvan esikat-
selukuvia. Valintaikkunan oikealla puoliskolla sijaitsevilla esikatse-
luruuduilla voi myös korjata kuvan kirkkautta ja tummuutta. 
 
 

3.5 Kuvan erottaminen taustasta 
 

Kuvan erottamista taustasta kutsutaan myös syväämiseksi. Varsinkin 
tuotekuvissa jopa valkoinen tausta saattaa muodostua haitaksi, kun 
kuvia sommitellaan taitto-ohjelmassa. Taustat menevät toistensa 
päälle ja pilaavat näin tuotteista syntyvän sommitelman. 
 
Jos tuotekuvassa on valkoinen tausta ja tuotteessa selvät reunat, hel-
poiten kuvan saa rajattua käyttämällä Photoshopissa Taikasauvaa 
(Magic Wand Tool). Kokeilemalla eri Tolerance-arvoja Taikasauva-
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työkalussa, voi hyvinkin löytää arvon, jolla koko taustan saa valittua 
ilman, että kuvan esine sisältyy valintaan. Tämän jälkeen täytyy va-
littu tausta poistaa kuvasta Delete-näppäimellä. 
 
Jos tausta on kirjava, eikä se ole tasaisen värinen, myös Photoshopin 
Filter>Extract (Erota) -komentoa kannattaa kokeilla. Siinä Reunojen 
korostaja (Edge Highlighter) -työkalua käyttämällä rajataan erotetta-
va esine. Rajaamisen jälkeen rajattu alue täytetään käyttämällä Täyt-
tö (Fill Tool) -työkalua. Esikatselu (Preview) -painikkeella näkee, 
miltä valinta näyttää ja sitä voi samalla myös korjata, jos on tarvis. 
 
Photoshop CS -version, tai sitä uudemman CS 2 -version, ja InDe-
sign CS -version välillä voi käyttää Photoshopin omia PSD-muotoi-
sia tiedostoja. Tästä on se hyöty, että valkoinen tausta pysyy poissa 
kuvasta tässä tiedostomuodossa. Jos esimerkiksi Photoshopissa pois-
taa taustan, ja tallentaa tiedoston JPG-muodossa, ilmestyy siihen 
valkoinen tausta takaisin. 
 
Eniten totuttelua vaativa keino taustan poistamiseksi on reittikynän 
(Pen Tool) käyttö. Reittikynällä saa kuitenkin tarkasti valittua kaare-
via esineitä, ja se on erittäin tehokas työkalu kuvien rajaamiseen 
(Kainulainen 2006: 129). Reittikynää käyttäen esine rajataan tukipis-
teitä käyttäen. Kun esine on rajattu Reittikynällä, muodostunutta 
aluevalintaa kutsutaan reitiksi. Reitin voi muuttaa Paths-välilehdeltä 
valinnaksi. Tämän jälkeen voi käyttää komentoa Select>Inverse, jol-
loin saa taustan valittua. Taustan voi nyt poistaa. 



 29

4 Toimitus painoon 
 
Kun työ on saatu siihen vaiheeseen, että se alkaa olla valmis lähetet-
täväksi painoon, tulee siihen tehdä viimeiset tarkistukset. Jos työhön 
sisältyy kuvia tai väripohjia, jotka ulottuvat sivun reunasta reunaan, 
julkaisuohjelmissa ko. elementtien pitää ulottua 3-5 mm yli reuno-
jen. Näin värit peittävät tarvittavan alan valmiissa painotuotteessa, 
eikä valkoisia reunoja esiinny. Muita tarkistettavia asioita ovat värit 
ja fontit, linkkitiedostojen toimivuus ja se, että kuvilla on oikea reso-
luutio ja ne ovat CMYK-muodossa. (Lehtonen ym. 2003: 66, 75.) 
 
Lehtosen ym. (2003: 66) mukaan tarkistus onnistuu helposti esimer-
kiksi julkaisuohjelmassa. InDesign:ssa toiminto File>Preflight tar-
kistaa taittotyön ja ilmoittaa muun muassa, ovatko kaikki linkkitie-
dostot oikeassa muodossa ja  ja mitä värijärjestelmiä kuvat käyttä-
vät. Kyseisellä toiminnolla voi myös tehdä uuden kansion koneelle, 
josta löytyvät käytetyt fontit, linkkitiedostot ja painettavaksi tarkoi-
tettu tiedosto. Koskinen (2001: 116) on listannut asiat, joita Preflight 
ja muut tarkastusohjelmat havaitsevat: 
 

• Elementtien ja kuvien linkitys puuttuu. 
• Kirjainfontit puuttuvat. 
• Kuvatiedostot puuttuvat. 
• Leikkausvarat puuttuvat. 
• Lihotukset tekemättä. 
• Lisävärejä ei ole muutettu prosessiväreiksi tai päinvaistoin. 
• Ohjelma ei pysty suorittamaan kuvatiedostojen koonmuuttoa 

tai kiertoa. 
• Puhtaaksileikkausmerkit puuttuvat. 
• Resoluutio on väärä. 
• RGB-muotoista TIFF-kuvaa ei ole muutettu CMYK-

muotoon. 
• Tekstielementtien värinaltapoisto on tekemättä. 
• Tiedosto sisältää matalaresoluutioisen näyttökuvan. 
• Tiedostossa on PostScript-virhe. 
• Tiedostot ovat epätäydellisiä tai vioittuneita. 
• Tiedostot ovat väärin linkitettyjä. 

 
Kun työ on tarkistettu, tallennetaan se muotoon, jollaisena se lähete-
tään painoon. Järjestelmästä riippumattomia ja valta-aseman saavut-
taneita tallennusmuotoja ovat Lehtosen ym. (2003: 61) mukaan 
Adoben kehittämät PDF (Portable Document Format) ja PostScript. 
 
PostScript on Adoben vuonna 1985 esittelemä sivunkuvauskieli ja 
tulostimien ymmärtämä digitaalinen muoto. PostScript-tiedosto pitää 
sisällään kaiken tarpeellisen tiedon sivujen tulostamiseen. Kun Post-
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Script-tiedosto halutaan tulostaa, ajetaan tiedoston sisältämä teksti- 
ja kuvadata Raster Image Processor:n (RIP) läpi. RIP tulkitsee ja 
kääntää PostScriptin komennoiksi, joita tulostinlaite tarvitsee kuvan 
tulostamiseen. Kleper (2001b: 298.) Vaikka PostScript-muotoinen 
aineisto on täysin valmis tulostettavaksi, ”kirjapaino ei voi korjata 
tai muuttaa sitä millään lailla” (Toro 1999: 87). 
 
Adoben vuonna 1993 julkaisema PDF on nykyään yleistynyt kirja-
painoon lähetettävän aineiston muotona. Vaikka PDF johdetaankin 
PostScript:sta, on sillä monia hyviä puolia verrattuna PostScript:iin. 
PDF-muoto pitää sisällään kaikki fontit ja kuvat, jotka dokumenttiin 
kuuluvat. Kun työ on tallennettu PDF-muotoon, sitä voi katsella ja 
selailla ilmaisen Adobe Acrobat Readerin avulla. Lisäksi ”PDF-tie-
dosto voidaan pakata parhaimmillaan kymmenesosaan alkuperäi-
sestä koostaan.” (Lehtonen ym. 2003: 69.) 
 
PostScript-tiedosto voidaan muuntaa PDF-muotoon joko taitto-ohje-
lmasta käsin tai esimerkiksi Acrobat Distiller -ohjelmalla. Lehtonen 
ym. (2003: 68) ei kuitenkaan suosittele tulostamaan PDF-tiedostoa 
suoraan InDesign-ohjelmasta, vaikka se onkin mahdollista. Syy tä-
hän on, että ”jotkin painotalot eivät pidä näin tuotettua PDF:ää luo-
tettavana” (Lehtonen ym. 2003: 68).  
 
PostScript-tiedosto tulostetaan taitto-ohjelmasta ja ajetaan sen jäl-
keen esimerkiksi Distiller-ohjelman läpi. Tuloksena syntyy PDF       
-tiedosto. Distiller-ohjelmaan voi tarvittaessa ladata uusimmat Jo-
boptions-asetukset painotalolta (Lehtonen 2003: 74). Painotalolta 
pyydetyt asetukset ovat valmiiksi optimoidut juuri valittua painoa 
varten. 
 
PDF-muotoon tallennettu aineisto näyttää periaatteessa samalta, kuin 
painosta tullut paperiversio. Näin ollen se soveltuu todella hyvin lä-
hetettäväksi työn tilaajalle tarkastusta varten. Oletetaan, että joka 
viikko työn tilaaja saa uuden version katalogistaan. Tällöin hän py-
syy tilanteen tasalla ja myös näkee, miten työ etenee.  
 
Aineiston voi myös lähettää natiivitiedostona eli sellaisena tiedosto-
na, jota käytetty taitto-ohjelma käyttää. Tällainen on esimerkiksi In-
Desing  -ohjelman .indd-muotoinen tiedosto. Kannattaa kuitenkin 
etukäteen selvittää, missä muodossa painotalo haluaa aineiston ottaa 
vastaan. Lehtonen ym. (2003: 78) suosittelevat, että taitto-ohjelmissa 
käytetään toimintoa Collect for output. Tämä kokoaa samaan kansi-
oon kaikki linkkitiedostot ja ohjelmasta riippuen myös fontit. Page-
Maker-ohjelmassa fontit tulee kopioida erikseen, InDesign ja Free-
hand kopioivat ne automaattisesti. 
 
Jos asiakas on tyytyväinen painotalon toimintaan, kannattaa hänen 
jatkossa harkita painotöiden keskittämistä juuri kyseiseen painota-
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loon. Ajan mittaan painotalo oppii tuntemaan asiakkaan. Tämän 
johdosta painon asiantuntija voi neuvoa asiakkaalle sopivat, ja mah-
dollisesti myös edullisemmat ratkaisut painotuotteen tekemiseen. Jos 
katalogin tekijällä ei ole ennestään kokemusta minkään painotalon 
kanssa asioinnista, kannattaa tehdä tarjouspyyntöjä eri painotaloille. 
Myös tuttavilta ja kollegoilta voi kysellä neuvoa ja mielipiteitä pai-
notalon valinnasta (Toro 1999: 80). 
 
On huomattava, että tietojen antaminen on hyödyllistä myös kirja-
painoille. Vaikka painot tarjoavat maksullisia palveluja koskien tait-
toa tai suunnittelua, auttaa se myös heitä. Kun asiakas on saanut 
työnsä valmiiksi, tulee se painotalolle myös kaikin puolin oikealla 
tavalla ja oikeassa muodossa. Tämä helpottaa myös heidän työtään 
ja julkaisu saadaan nopeammin painettua. (Toikkanen 2003: 23.) 
 
Kun tarjouspyynnöt on saatu ja tarkastettu ja näin sopiva painotalo 
valittu, siitä kannattaa ilmoittaa valitulle painotalolle. Tämä on hy-
vän tavan mukaista ja painotalo osaa varautua tilaukseen (Toro 
1999: 117). Aineiston mukana lähetetään aina painotyötilaus. Pai-
notyötilauksen tulee Koskisen (2001: 114) mukaan ilmetä seuraavat 
asiat: painotuotteen koko, sivumäärä, painovärien määrä, painome-
netelmä, selvitys painoon luovutettavasta aineistosta, arkistoidaanko 
aineisto painon toimesta ja kuinka pitkään, materiaalit, rakenne ja 
pakkaustapa sekä painosmäärä ja tarjouksen mukainen hinta. Tilauk-
sesta tulee ilmetä myös tilaajan yhteystiedot ja henkilö, jolta voi 
pyytää lisätietoa. 
 
 

4.1 Katalogin julkaiseminen verkossa jaettavaksi 
 

Nykyään monesta sanomalehdestä on olemassa näköisversio Inter-
netissä. Kyseessä ei ole täysi kopio paperisesta vastakappaleestaan, 
vaan sitä on muokattu verkkoa varten. Internetissä julkaistuista leh-
distä käytetään nimeä näköisversio, sillä ne ovat samannäköisiä kuin 
paperiset versiot niistä. Mikään ei kuitenkaan estä julkaisemasta leh-
teä tai katalogia sellaisenaan verkossa, ilman mitään verkon tuomia 
erikoisuuksia (Alasilta 2002: 293). 
 
Verkossa julkaistaviin lehtiin voidaan liittää esimerkiksi hyperlink-
kejä, joilla lukija voidaan ohjata hakemaan lisää tietoa kyseisestä 
asiasta. Lisäksi mainostajien WWW-osoitteet näkyvät näköislehdes-
sä hyperlinkkinä, joten kynnys ajautua mainostajan WWW-sivulle 
on paljon pienempi kuin tavallista lehteä selattaessa. Verkkojul-
kaisussa lukijan tarvitsee vain napauttaa linkkiä, sillä hän on jo tie-
tokoneen ääressä valmiina siirtymään seuraaville sivuille. Voisi pää-
tellä, että verkkojulkaisujen yleistyessä, tämä ominaisuus ei ole mai-
nostajille huono asia. Hyperlinkit voivat olla jossain tapauksissa 
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myös pitkiä ja monimutkaisia kirjoittaa esimerkiksi paperille ylös. 
Joissakin lehdissä annetaan mielenkiintoinen linkki, jonka pituus on 
lähes puolet lehden sivusta - riippuen tietysti käytetystä kirjasinlajis-
ta ja koosta. Hyperlinkin avulla tällaiselle sivulle on helpompi siirtyä 
kuin kopioimalla teksti lehdestä. 
 
Lukijaa voidaan hyperlinkityksen avulla auttaa siirtymään tietylle 
sivulle. Katalogiin pystytään helposti kokoamaan sisällysluettelo si-
vujen otsikoista. Muuttamalla sisällysluettelon kohdat hyperlin-
keiksi, pääsee lukija nopeasti tahtomalleen sivulle ilman, että hänen 
täytyy selata koko katalogin läpi. 
 
Verkkojulkaisun mielekkyyteen voi myös vaikuttaa lisäämällä siihen 
ääntä ja kuvaa. Katalogissa tuotteesta voi antaa yksityiskohtaiset tie-
dot pienellä videoesittelyllä, jossa on sekä selostusta tuotteesta, että 
myös liikkuvaa kuvaa. Jos jokaisen tuotteen kohdalla on tällainen 
esitys, kasvaa työmäärä huomattavasti ja samalla myös katalogin 
koko. 
 
Julkaisu voidaan siirtää verkkoon myös täysin samanlaisena versio-
na kuin paperiversiokin. Alasillan (2002: 293) mielestä tämä palve-
lee lukijoita ja on kohtuuhintainen vaihtoehto. Esimerkiksi pieni-
muotoinen katalogi voidaan siirtää PDF-muodossa verkkoon ja asi-
akkaat voivat selata sitä sieltä käsin, riippumatta siitä, missä päin 
maailmaa he ovat. Suuremmissa katalogeissa latautuminen saattaa 
hidastua, sillä ne sisältävät enemmän kuvia ja muuta materiaalia. 
Verkosta asiakas voi mahdollisesti myös tulostaa katalogin omaan 
käyttöönsä. 
 
Katalogin voi periaatteessa toteuttaa siten, että se julkaistaan vain 
verkossa. Linkin katalogiin voi laittaa näkyville jonnekin yrityksen 
WWW -sivuille. Suurin hyöty tässä on se, että painokustannuksia ei 
tule, eikä katalogeja tarvitse postittaa minnekään. On kuitenkin otet-
tava huomioon se mahdollisuus, että kaikki eivät tahdo tai pysty lu-
kemaan julkaisuja verkosta. Tämän vuoksi olisikin hyvä, jos asiakas 
voisi tilata yritykseltä perinteisen paperiversion heidän katalogis-
taan. 
 
Julkaisun lukeminen verkosta ei välttämättä ole kuitenkaan yhtä 
mieluista kuin paperiversion lukeminen. Itse asiassa tietokoneen 
ruudulta lukeminen on hitaampaa kuin paperilta, ja se voi joistakin 
tuntua myös raskaammalta. Jos julkaisu sisältää paljon leipätekstiä, 
kannattaa se jakaa riittävän lyhyisiin kappaleisiin ja rivin pituus tu-
lee olla lyhyempi kuin perinteisessä julkaisussa. 
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5 Case: Hoo-Hoo Oy:n liikelahjakatalogi 
 
Alun perin katalogin piti tehdä käyttäen Adobe PageMaker -ohjel-
maa. Itselläni ei ollut kyseisestä ohjelmasta käyttökokemusta. Tästä 
syystä ehdotin toimeksiantajalle, onnistuisiko työn tekeminen Adobe 
InDesign:lla. InDesign:a olin käyttänyt opintoihini liittyvillä kurs-
seilla, ja osasin sitä käyttää hyvin. Tämä sopi hyvin toimeksiantajal-
le. Grafiikkaan ja kuvankäsittelyyn liittyvät asiat oli tarkoitus tehdä 
Adobe Photoshop -ohjelmalla. Photoshopia olin käyttänyt sekä kou-
lussa että vapaa-ajalla. 
 
Aivan ensimmäisessä palaverissa mietittiin, millä aikataululla ja 
minkälaisilla resursseilla katalogin teko aloitettaisiin. Toimeksianta-
ja oli jo valmiiksi miettinyt joidenkin sivujen teemaa ja sisältöä. En-
simmäiset luonnostelmat sivuista tehtiin ruutupaperille. Siihen oli 
merkitty sivun teema eli otsikko. Otsikon alle kirjattiin tuotteet, jois-
ta piti saada kuvat. Ensimmäisellä kerralla syntyi näin noin neljä si-
vun luonnostelmaa. 
 
Sain toimeksiantajalta tuotteiden valmistajien osoitteita sekä CD-
ROM-levyllisen valmiita tuotekuvia. Sain myös muutaman valmista-
jan kuvapankkiin tunnukset. Lopuksi sovittiin, että hankkisin luon-
nostelluille sivuille tarvittavat kuvat ja sen jälkeen katsottaisiin, mi-
ten jatketaan. Alustavasti sovittiin, että tuotekuvat sommitellaan pa-
perikoolle A4 (210 mm x 297 mm). Katalogin toteutuksen edetessä 
kyseinen koko osoittautui kuitenkin liian suureksi. Katalogin sivuille 
jäi liian paljon tyhjää tilaa, jolloin sivu näytti liian harvalta. Tämän 
tuloksena paperikooksi valittiin A5 (148 mm x 210 mm). Sivujen 
lukumääräksi toimeksiantaja oli suunnitellut 16 sivua. 
 
CD-ROM-levyllä olleista kuvista jotkut olivat sellaisia, että ne voi-
tiin laittaa katalogiin, kunhan valkoinen tausta oli erotettu niistä. 
Mukana oli myös kuvia, jotka olivat resoluutioltaan ja pikselikool-
taan liian pieniä käytettäväksi katalogissa.  
 
Kaikilla valmistajilla, joilta kuvia piti saada, ei ollut kuvapankkia 
netissä. Jos katalogi olisi tuotettu vain verkkoa varten, valmistajien 
sivuilla olevia kuvia olisi voitu käyttää myös katalogissa. Katalogis-
ta piti tulla perinteinen painoversio, joten kuvien piti olla mielellään 
niin hyvälaatuisia kuin mahdollista. Toimeksiantaja tilasi suoraan 
tuotteiden valmistajilta parempilaatuisia kuvia. Mitä suurempia ku-
vat olivat pikselikooltaan, sitä helpompi niitä oli rajata ja muokata 
katalogia varten. 
 
Suunnittelin InDesign:n avulla katalogin sivuille yksinkertaisen 
yleisilmeen. Sen ei pitänyt olla lopullinen, vaan näyttämään suunnil-
leen, miten eri otsikot sopisivat sivulle. Toimeksiantajalle katalogin 
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ulkonäkö sopi hyvin, joten alkuperäinen yleisilme jäi pysyväksi. Ka-
talogin etukanteen piti myös alun perin tulla vain pelkkä Hoo-Hoo 
Oy:n nimi ja väriksi vaaleansininen liukuväri. Etukannen liukuväri 
muutettiin kuitenkin tasaiseksi vaaleansiniseksi väriksi. Hahmottelin 
vapaa-ajallani siihen kuitenkin jonkinlaista kuviota ja tämä miellytti 
toimeksiantajaa. Takakanteen sommiteltiin Hoo-Hoo Oy:n yhteys-
tiedot. Alun perin etukanteen suunniteltu liukuväri laitettiin takakan-
teen (Kuvio 14) (Liite 1 Hoo-Hoo Oy:n katalogi). 
 

 
 
Kuvio 14 Leike Hoo-Hoo Oy:n liikelahjakatalogin etu- ja takakan-
nesta. 
 
Se, että InDesign:ia käytettiin apuna katalogin taitossa, oli käytän-
nössä helppo päätös. Toimeksiantajalla oli aluksi mielessä, että kata-
logi taitettaisiin PageMaker-ohjelmalla. En ollut käyttänyt kyseistä 
ohjelmaa ennen. Koulun koneilta ohjelma löytyi, joten käytännössä 
taitto olisi voitu tehdä sen avulla. Ehdotin toimeksiantajalle voisiko 
katalogin taittaa InDesign:n avulla. Olin DTP-kursseilla tehnyt töitä 
sen avulla ja osasin käyttää sitä tarpeeksi hyvin. PageMaker:n käyt-
töönotossa kynnys oli korkeampi, sillä siihen olisi ensiksi pitänyt tu-
tustua tarkemmin, ennen kuin työn teon olisi voinut aloittaa. Toi-
meksiantajalle InDesign:n käyttö sopi hyvin. 
 
Katalogin sivuilla sama yleisilme toistui vain siten, että sivun otsik-
ko oli jokaisella sivulla samanlaisella pohjalla ja samalla tasolla. Ot-
sikon teksti ja se, kumpaan reunaan teksti oli sijoitettu, vaihteli. Tuo-
tekuvien sijoittelussa katalogin sivuille, ei käytetty mitään kovin-
kaan paljon hyväksi kultaista leikkausta tai tasapainolinjaa. Kuvien 
sommittelussa painotettiin sitä, että yleisilme sivuilla miellytti sil-
mää. Lisäksi samojen tuotteiden eri väriset kappaleet sijoitettiin 
usein jonkinlaiseen muodostelmaan. Esimerkiksi lippalakit muodos-
tivat keskenään ympyrän. 
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Valmiista tuotekuvista suurimman osan sai irrotettua hyvin taustas-
taan. Alussa tähänkin toimenpiteeseen liittyi pieni ongelma. Kun 
tuotekuvan oli saanut irti valkoisesta taustasta, kuvaa tallennettaessa 
JPG-muodossa kuvalle ilmestyi uudestaan valkoinen tausta. Ongel-
ma ratkaistiin sillä, että käsitellyt kuvat tallennettiin Photoshopin 
PSD-natiivimuodossa. Tällöin taustaa ei tullut kuvaan, kun se tuotiin 
InDesign:iin. Kun tuotekuvilla ei ollut taustaa, ne oli helpompi 
sommitella toistensa lähelle ja päällekkäin. 
 
Kuvien syväykseen käytettiin varsinkin valmiissa tuotekuvissa Pho-
toshopin Taikasauva-työkalua. Koska tausta oli täysin valkoinen, 
Taikasauvan Tolerance-arvoa muuttamalla kuvan sai syvättyä suu-
remmitta ongelmitta. Hankalammissa kuvissa, joissa oli taustalla eri 
värejä ja muotoja, Photoshopin Extract-toiminto toimi hyvin. Kuvia 
voi vielä tämän jälkeen esimerkiksi Historiasiveltimellä hienosäätää. 
 
Ne kuvat, joita ei saatu kuvapankeista, CD-ROM-levyiltä tai valmis-
tajalta tilaamalla, otettiin digitaalikameralla. Tällaisia kuvia olivat 
esimerkiksi katalogin ulkonäköön liittyvät kuvat. Näillä kuvilla ei 
esitelty välttämättä tuotteita, vaan ne palvelivat sisällöllisinä ele-
mentteinä katalogin sivuilla. 
 
Digitaalikameralla otetuille kuville täytyi tehdä enemmän kuvankä-
sittelyä kuin valmiille tuotekuville. Valmiissa kuvissa valaistus ja 
tuotteen värit toistuivat oikein, itse otetuille kuville täytyi suorittaa 
muun muassa kuvan rajausta sekä värin korjaamista. Esimerkistä 
käy hyvin eräs sukkakuva. Sukan valkoinen alue näytti punertavalta, 
joten koko kuvan värisävyä piti säätää hieman vihertävään päin. 
Käytännössä kuville olisi pitänyt tehdä myös terävöittämistä. Tämä 
asia tuli tietooni vasta opinnäytetyötä kirjoittaessani. Valmiissa, pai-
netussa katalogissa kuvat ovat tulostuneet hyvälaatuisina. 
 
Photoshopissa kuvia käsiteltiin RGB-väritilassa. Aivan alusta asti en 
käyttänyt värinhallintaa katalogia tehdessäni. Vasta kun luin Evenin-
gin:n kirjan, kalibroin ja profiloin kotikoneeni. Käytin apunani Ado-
be Gamma -ohjelmaa, sillä se oli parempi kuin ei mitään. Työprofii-
liksi RGB-kuville valitsin Adobe RGB -väritilan. Kuvat käsittelin 
RGB-tilassa ja ennen tallennusta muutin ne CMYK-väritilaan. 
Työprofiilina CMYK-kuvilla oli Europe ISO Coated Fogra27. In-
Design:n värinhallinnan löysin valitettavasti vasta sen jälkeen, kun 
katalogi oli jo painettu. Varsinkin katalogin etukannen värin kanssa 
ei olisi ollut niin paljon ongelmia, jos värinhallinta olisi ollut käy-
tössä myös InDesign:ssa. Jostakin syystä katalogin etukannen värin 
sävy muuttui, kun katalogi muutettiin PDF-muotoon. Loppujen lo-
puksi värisävy saatiin oikean sävyiseksi. 
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Uskon värien muuttumisen johtuneen siitä, että InDesign:ssa värin-
hallinta oli oletusarvoisesti poissa päältä. Jälkeenpäin, ohjeiden avul-
la, asetin InDsign:n värinhallinnan toimimaan kunnolla. Tämä mah-
dollisti värien näkymisen samanlaisena PDF-tiedostossa kuin In-
Design:ssa. Kaikkien katalogien kuvien resoluutioksi asetin 300 ppi, 
jotta kuvat tulostuisivat hyvälaatuisina kirjapainossa. 
 
Katalogin sivut muuttuivat käytännössä koko ajan. Uusia kuvia li-
sättiin katalogiin ja joitakin poistettiin, sillä huomattiin, että ne eivät 
ole tarpeen. Tuotekuvien sommittelua muutettiin aina kun lisää tuot-
teita tuli sivuille. Joitakin tuotteita siirrettiin sivulta toiselle ja jopa 
yksi uusi sivu luotiin tällaisista, muilta sivuilta siirretyistä tuotteista. 
Tästä syystä alussa olisi ehkä pitänyt enemmän suunnitella sitä, mitä 
tuotteita laitetaan millekin sivulle. 
 
Käytännössä työn kulku meni siten, että toimeksiantaja ehdotti tasai-
sin väliajoin uusista kuvista tai uuden sivun teemasta. Sain toimek-
siantajan kautta uuden kuvat, jotka käsittelin ja liitin katalogiin. 
Toimeksiantaja antoi palautetta ja ehdotuksia, miten hän halusi ku-
vat sommiteltavan. 
 
Kun katalogi alkoi olla siinä vaiheessa, että kaikki tarvittavat tuote-
kuvat olivat sivuilla, kuvien viereen lisättiin tuotteiden tiedot. Tie-
toihin tuli tuotenumero, tuotteen nimi sekä joistakin tuotteista fyysi-
set mitat, sillä kuvat eivät olleet oikean kokoisia suhteessa toisiinsa. 
Tämä auttaa lukijaa paremmin käsittämään tuotteen koon. Jotta tuot-
teiden tiedot yhdistettäisiin oikeisiin tuotteisiin, asetettiin tiedot ky-
seisen kuvan viereen. Tuotteiden tiedot asetettiin siten, että väärin-
käsityksiä siitä, mistä tuotteesta on kyse, ei pääse muodostumaan. 
Tuotekuvien tiedot kirjoitettiin groteskilla Lucida Sans -kirjasinla-
jilla. Myös sivujen otsikoissa käytettiin samaa kirjasinlajia. Sivujen 
otsikoissa käytettiin pistekokoa 24. Koko on sen verran suuri, että 
lukija huomaa otsikot hyvin. 
 
Koko katalogin toteuttamisen ajan toimeksiantaja pystyi tarkista-
maan, missä vaiheessa katalogin toteutus oli. Muutoksia tehtyäni 
siirsin FTP-yhteyttä käyttäen katalogin verkkoon, josta työnantaja 
pystyi lataamaan sen koneellensa ja tarkastamaan, miltä se näytti. 
 
Kun katalogi oli sisällöllisesti valmis, siitä tehtiin painovalmis PDF       
-tiedosto käyttäen InDesign-ohjelman Export-toimintoa. Esivalin-
naksi valittiin Press. Kyseinen toiminto tekee In Design:ssa tehdystä 
työstä PDF-tiedoston. Esimääritettyjä asetuksia voi toki myös muut-
taa. Opinnäytetyötä kirjoittaessa tuli ilmi, että muunto PDF-tiedos-
toksi olisi kannattanut tehdä Acrobat Distiller -ohjelmaa apuna käyt-
täen. Yritin myöhemmin uudestaan tehdä katalogista painovalmiin 
dokumentin. Käytin InDesign:n Preflight-komentoa kootakseni tar-
vittavat elementit yhteen kansioon. Tämän jälkeen muutin Acrobat 
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Distillerin avulla katalogin PDF-muotoon. Tällä tavalla muunto on-
nistui helposti ja Preflight:n avulla näki heti, onko kaikki kunnossa. 
 
Hoo-Hoo Oy:n katalogin kohdalla kirjapainon valinta oli helppo. 
Toimeksiantaja oli ennenkin käyttänyt Domus-Offset Oy:n palvelui-
ta. Perusteena kyseisen painotalon valinnalle oli palvelun toimivuus 
ja se, että materiaali valmistui sieltä suhteellisen nopeasti. Näin ollen 
painotalon valintaa ei tarvinnut miettiä etukäteen.  
 
Materiaalin toimittamisesta kirjapainoon sovittiin, että toimeksianta-
ja käy henkilökohtaisesti sopimassa painoon tulevasta materiaalista. 
Katalogi oli bittikooltaan sen verran suuri, ettei sen lähettäminen 
sähköpostitse onnistuisi. Järkevä vaihtoehto oli aineiston toimittami-
nen CD-ROM-levyllä. Tallensimme aineiston CD-ROM-levylle, ja 
toimitimme sen kirjapainoon. Mukaan liitettiin kaiken varalta kaikki 
käytetyt kirjasinlajit, natiivitiedostot sekä kuvat. Painotalon Internet-
sivuilta löytyi ohje aineiston toimituksesta painoon. Painoaineiston 
mukana tuli lähettää raportti, jossa kerrottiin painotuotteen aikataulu 
ym. tarvittavat tiedot. Ohjeet kirjapainolle kirjattiin ylös ja lähetet-
tiin sähköpostilla kirjapainoon. Toimeksiantaja toimitti painoaineis-
ton kirjapainoon. 
 
Kirjapaino otti kuitenkin uudestaan yhteyttä, sillä jostakin syystä 
painovalmis PDF-tiedosto oli lähetetty heille RGB-väritilassa. Vaik-
ka kaikki kuvat olivat tallennettu kuvankäsittelyn jälkeen CMYK     
-muotoon, jostain syystä PDF-tiedosto ei ollut vastaavassa väritilas-
sa. Vika kuitenkin löytyi nopeasti. Kun katalogista tehtiin PDF-tie-
dosto, piti Export-toiminnon Advanced-välilehdeltä valita väritilaksi 
CMYK. Aiemmin sitä ei oltu muutettu ollenkaan. 
 
Paperi, jolle Hoo-Hoo Oy:n katalogi painettiin, on vahvuudeltaan 
normaalia kopiopaperia paksumpaa. Se on myös päällystettyä ja kiil-
täväpintaista. Päällystetyllä paperilla kuvat, joita katalogissa on suh-
teessa eniten kaikkiin muihin sisältöelementteihin verrattuna, näyt-
tävät paremmilta kuin päällystämättömällä. Paperin valintaan pää-
dyttiin siten, että painotalo esitti toimeksiantajalle erilaisia suo-
siteltavia paperilaatuja, joista valittiin parhaiten työhön soveltuva 
laatu. 
 
Katalogista piti alun perin tulla vain painoon tarkoitettu versio, mut-
ta lopulta toimeksiantaja tiedusteli, voisiko sen julkaista myös ver-
kossa sellaisenaan. Tämä sopi hyvin, sillä painoon tarkoitettu versio 
oli jo valmiiksi sähköisessä PDF-muodossa. Katalogin kuvista oli 
tehty resoluutioltaan pienemmät versiot WWW-sivuja varten. Näi-
den kuvien resoluutio oli 72 ppi. Aikatauluun liittyvistä syistä johtu-
en, katalogin tuotekuvia ei ehditty vaihtaa resoluutioltaan pienem-
piin kuviin. Verkossa julkaistu PDF-versio tehtiin lopulta siten, että 
InDesign:ssa käytettiin Export-toiminnon eBook-esivalintaa. Tällöin 
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PDF-versiosta tuli tiedostokooltaan pienempi kuin painoon tarkoite-
tusta versiosta. Tosin sen olisi voinut saada vieläkin pienemmäksi, 
jos olisi käyttänyt resoluutioltaan pienempiä kuvia. Verkossa jul-
kaistun katalogin tiedostokoko oli 2,98 Mt ja painoon lähetetyn 14,8 
Mt. 
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6 Yhteenveto 
 
Työssä onnistuttiin löytämään keskeiset kohdat, joita täytyy ottaa 
huomioon katalogin tekemisessä. Painotuotteen suunnitteluun ja to-
teuttamiseen liittyy tosin paljon asioita, jotka tulee ottaa huomioon. 
Opinnäytetyöhön olisi voinut sisällyttää paljon asioita, jotka liittyvät 
kirjapainamiseen. Opinnäytetyön tavoitteena oli kuitenkin esitellä 
tästä prosessista keskeisiä kohtia. Näin ollen työn rajaaminen tärkei-
siin kohtiin onnistui. 
 
Kirjallisuuden käyttämiseen liittyi käytännön rajoituksia. Jotkin mie-
lenkiintoiset teokset olivat liian vanhoja käytettäväksi luotettavina 
lähteinä. Pelkästään katalogin tuottamiseen keskittynyttä kirjallisuut-
ta ei opinnäytetyön tekemistä varten löytynyt. Painoteollisuuteen 
keskittyneestä kirjallisuudesta sai kuitenkin hyvin tietoa eri osa-
alueilta. Lisäksi valokuvaukseen liittyvä kirjallisuus tuki hyvin 
opinnäytetyön kirjoittamista. Loppujen lopuksi ajan tasalla olevaa 
tietoa löytyi hyvin. 
 
Opinnäytetyötä olisi tukenut esimerkiksi laadullinen tutkimus. Tut-
kimukseen olisi koottu tuotetun katalogin hyviä ja huonoja puolia. 
Mahdollisesti tulevaisuudessa suunniteltavan katalogin tekemisessä 
voitaisiin käyttää kerättyä palautetta. Palautteen ansiosta katalogia 
voitaisiin parantaa enemmän asiakkaiden toiveita vastaavaksi. 
 
Mitä tulee opinnäytetyön tavoitteeseen? Tavoitteena oli tehdä ym-
märrettävä ja tiivis paketti katalogin suunnittelusta sekä luomisesta. 
Tavoite oli myös että kuka tahansa joka suunnittelee katalogin teke-
mistä, voisi käyttää opinnäytetyötä apunaan. Tavoitteiden saavutta-
minen onnistui hyvin. Raportissa koitettiin pitää kieli tarpeeksi ym-
märrettävänä, jotta sitä olisi helppo lukea ja sitä se on. Syventymättä 
liikaa pieniin yksityiskohtiin ja alan termistöön, opinnäytetyö kertoo 
asiat kattavasti. Seuraavan katalogin tekoa suunniteltaessa työtä ei 
tarvitse aloittaa täysin puhtaalta pöydältä, vaan on edes pieni oh-
jenuora, jota voi käyttää apuna.  
 
Tulevaisuudessa olisi mukava tehdä pelkästään verkossa julkaistava 
katalogi, tai muu julkaisu. Silloin eri elementteihin voisi liittää hy-
perlinkkejä, jotka ohjaisivat lukijaa julkaisun sisällä, esimerkiksi si-
sällysluettelosta tietylle sivulle. Hoo-Hoo Oy:n katalogin ensimmäi-
sellä sisäsivulla oli valmistajien logoja. Myös näihin voisi liittää hy-
perlinkityksen, jolloin siirtyminen tapahtuisi valmistajan sivulle. 
 
Vaikka opinnäytetyö ei vastaisikaan sitä normaalia työkulkua, jolla 
julkaisut yleensä tehdään, antaa se kuitenkin hyvät ohjeen katalogin 
tekoon. Voisi luulla, että yhdenkään julkaisun tekeminen prosessina 
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ei ole koskaan samanlainen kuin joku toinen - se on sitä vain pää-
piirteittäin. 
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Sanasto 
 
Additiivinen värijärjestelmä 
Järjestelmässä väri muodostetaan projisoimalla valoa kuvapinnalle. 
Kuva vaalenee, kun väriä lisätään. (Keränen ym. 2005: 378.) 
 
CMYK-värijärjestelmä 
Järjestelmällä painetaan värillisiä painotuotteita. 
 
Dpi 
Arvo, kuinka monta mustepistettä tulostin tulostaa tuumaa kohti. 
Dots per inch. 
 
DTP 
Desktop Publishing. Tietokoneen, skannerin ja tulostimen muodos-
tama, painotuotteiden valmistusjärjestelmä (Koskinen 2001: 226). 
 
ICC 
International Color Consortium. Kansainvälinen valaistuskomissio. 
 
InDesign 
Adoben kehittämä julkaisuohjelma. 
 
Kalibrointi 
Laitteistojen toimintojen säätäminen tuottamaan standardoituja tai 
yhteisesti hyväksyttyjä tuloksia (Koskinen 2001: 226). 
 
Lpi 
Arvo, jolla ilmoitetaan rasterilinjojen määrä tuumaa kohti. Lines per 
inch. Linjatiheys määrää kuvalta vaadittavan resoluution. Resoluuti-
on tulisi olla 1,5-2-kertainen linjatiheyteen nähden. (Keränen ym. 
2005: 87.) 
 
Pikselikoko 
Kuvan mittasuhteet pikseleinä. Esimerkiksi 800 x 600 pikseliä. 
 
Ppi 
Arvo, joka kertoo kuinka paljon kuvassa on pikseleitä tuumaa kohti. 
Pixels per inch. 
 
Prosessivärit 
Värikuvan painamiseen tarvittavat neljä väriä: syaani, magenta, kel-
tainen ja musta (CMYK) (Koskinen 2001: 226). 
 
Rasterointi 
Tulostimet luovat värit ja harmaasävyt tulostamalla eri kokoisia 
mustepisteitä tiheästi vierekkäin (Keränen ym. 2005: 387). 
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Resoluutio 
Kuinka paljon yksityiskohtia kuvassa on. Kuinka tiheästi kuvapisteet 
monitori tai tulostin sijoittaa ((Keränen ym. 2005: 388). 
 
RGB-värijärjestelmä 
Järjestelmässä värit muodostetaan käyttäen kolmea pääväriä; punais-
ta, vihreätä ja sinistä. 
 
Subtraktiivinen värijärjestelmä 
Järjestelmässä kuva tummenee, kun painoväriä lisätään paperille 
(Keränen ym. 2005: 389). CMYK-järjestelmä on subtraktiivinen vä-
rijärjestelmä. 
 
Tukkoonmeno 
Tarkoitetaan sitä, kun liian suuri valo- tai värimäärä kasvattaa raste-
ripisteitä siten, että myös pisteiden väliset alueet siirtävät väriä pai-
nopintaan. Esimerkiksi teksti näyttää paperilla suttuiselta. 
 
Väriavaruus 
”Kolmiulotteinen malli, jolla kuvataan värien ominaisuuksia eri vä-
rijärjestelmillä” (Koskinen 2001: 236) 
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